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Objectives  
 
Upon completion of this section, you will:    
 

: have an overview of navigating in BEN Financialsô applications 

: learn how to logon to BEN Financials 

: know how to navigate in BEN Financials 

: learn how to perform inqui res on assets 

: demonstrate how to update asset information  

: learn how to retire an asset 

: understand how to reinstate an asset 

: learn how to run reports from BEN Assets 
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Overview of BEN   

Business Enterprise Network (BEN)  

Pennôs business and financial management systems which includes web-enabled applications & support  

Desktop Configuration  

Consistent with current University standards  

http://www.finance.upenn.edu/ben/benfin/desktop_req/  

 Local Support Providers (LSPôs)  

http://www.upenn.edu/computing/view/support/staff.html  

 List of primary computer support assigned by Center and by Department  

Access/Security  

Penn eForms 

http://www.upenn.edu/computing/da/eforms/     

Important Web Addresses  

U@Penn Portal 

http://medley.isc -seo.upenn.edu/penn_portal/ u@penn.php  

 Access to a wide variety of University web sites and information including those listed below  

BEN Financials Homepage   

http://benapps.isc -seo.upenn.edu  

 Access to BEN Financials, BEN Deposits, and BEN Reports 

Business Enterprise Network   

http://www.finance.upenn.edu/ben  

 News, Calendar, BEN Reps, BEN Knows, Frequently Asked Questions, Support Information, etc. 

Property Management Group 

http://www.finance.upenn.edu/comptroller/accounting/property/  

 Business Processes and Procedures, Category Codes, Forms, etc. 

Financial Training Department Web Page   

http://www.finance.upenn.edu/ftd/  

 Information regarding courses offered, register for training, the Bottom Line Newsletter, etc.  

Audit and Compliance Web Page   

http://www.upenn.edu/a udit/  

 Information on controls, compliance mechanisms, and technologies to manage risk as well as 

providing guidance on the stewardship of University resources 

Responsibility Center Management (RCM) 

http://www.finance.upenn.edu/comptroller/rcm/index.shtml  

 Information about BEN Financials Reports, Fund Aggregations & Object Code Aggregations, etc. 

http://www.finance.upenn.edu/ben/benfin/desktop_req/
http://www.upenn.edu/computing/view/support/staff.html
http://www.upenn.edu/computing/da/eforms/
http://medley.isc-seo.upenn.edu/penn_portal/u@penn.php
http://benapps.isc-seo.upenn.edu/
http://www.finance.upenn.edu/ben
http://www.finance.upenn.edu/comptroller/accounting/property/
http://www.finance.upenn.edu/ftd/
http://www.upenn.edu/audit/
http://www.finance.upenn.edu/comptroller/rcm/index.shtml
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Overview of BEN (continued)  

Need Help?  

  Dial 6-HELP (6-4357 or 215/746-4357) 

 Enter your two-digit School or Center code 

 BEN Helps is available 9:00 a.m. to 5 p.m. Monday through Friday 

 BEN Knows 

http://www.finance.upenn.edu/benknows/  

 Browse and search for possible solutions to your BEN Financials and BEN Reports questions 

Penn eForms  

Penn eForms are required for entry to most University financial systems. These eForms should be 

processed promptly to ensure system access following training. If a n eForm has not been processed 

within two m onths or more of attending a training course , you will be required to repeat the 

course to obtain access. 

F If you need your BEN Financials password reset call 8-1099.    

 

http://www.finance.upenn.edu/benknows/
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Glossary of Terms  
 

Before using BEN Financials, you should familiarize yourself with the specifics of the GUI (Graphical User 

Interface) or web environment and how to perform basic tasks, such as using a menu or selecting an item. 
In doing so, you should come across and become familiar with the following generic terms:  
 

Block  
 Each window consists of one or more blocks.  All required fields in a block must be completed before 

 you can move to the next block.  
 

Click  
 Quickly press and release a mouse button while the mouse pointer is on a particular item.  
  
Desktop  

 The part of the compute r monitor that displays where your work takes place, a.k.a. your screen.  
 

Double -click  

 Rapidly click a mouse button twice while the mouse pointer is on a particular item.  
 

Folders  
 Refers to the custom preferences which allow you to determine what colum ns (fields) appear in your 

 view of the data.  
 

Homepage  
 The BEN Financials Homepage provides a point of entry into BEN Financials. 
 

LOV 
 The list of values in a particular field denoted by the ellipsis to the right of the field.  
 

Menu  

 A list that appears in a bar across the top of a window that consists of commands or actions you            

 can perform. 
 

Plug -Ins  
Plug-ins are software programs that extend the capabilities of the Netscape Browser in a specific way.   

J-Initiator and MarkView are software plug-ins that work with the web browser to run graphical BEN 
applications on a Windows PC or a Macintosh running Virtual PC.  J-Initiator must be installed before the 

MarkView plug-in is installed. 
 

Record  

 A record is one occurrence of data stored in all the fields of a block.  Also referred to as a row.  
 

Region  
 A collection of related fields set apart from other fields within a block. Regions help to organize a 

 block so that it is easier to understand.  
 

Scroll Bar  
 A vertical or horizontal bar that app ears on a window whose contents are not entirely visible. Click on 

 the arrows, or drag on the box of a scroll bar to scroll through the hidden contents, or click in the bar 

 itself to move to either the previous or next page.   
 

Toolbar  
 The toolbar is a collection of function buttons.  Each toolbar button replicates a commonly -used 

 menu item.  Depending on the context of the current field or window, a toolbar button will be either 
 enabled or disabled. 
 

Window/Form  

Replaces the word óscreenô and used interchangeably throughout BEN Financials. 
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BEN Assets Glossary  
 

Accumulated Depreciation   

 The total depreciation taken for an asset since it was placed in service. Also known as life-to-date 
depreciation and depreciation reserve. 

 

Asset Account      

 A general ledger account to which you charge the cost of an asset when you purchase it.  
 

Capitalized Asset    
 Capitalized assets are assets that you depreciate (spread the cost expense over time). The Asset Type 

for these assets is "Capitalized". 
 

Clearing Accoun t    
 An account used to ensure that both sides of an accounting transaction are recorded. For example, 

when you purchase an asset, your payables group creates a journal entry to the asset clearing account. 

When the Property Management Group records the asset, they create another journal entry to the asset 
clearing account to balance the entry from Accounts Payables. 

 

Equipment in Process (EIP)  

 Refers to costs incurred for fabricating non -expendable, tangible personal property that  is not available 
elsewhere, by physically combining or assembling modular components and/or materials into one 

identifiable unit are considered EIP until the equipment is completed and placed in service.  When you 
finish the assets and place them in service (capitalize them), Oracle Assets begins depreciating them.  

In the BEN Assets Application  this term is referred to as Construction in Process (CIP) . 
 

Date Placed in Service    

 The calendar date on which you start using an asset.  At Penn, this will default from the invoice date,  
unless PMG is informed otherwise. 

 

Depreciate   

 To depreciate an asset is to spread its cost over the time you use it. You charge depreciation expense 
for the asset each period. The total depreciation taken for an asset is stored in the accumulated 

depreciation account. 
 

Expensed Asset   
 An asset that you do not capitalize but charge the entire cost to expense in a single period. 
 

Fixed Asset    

 An item owned by your business and used for operations. Fixed assets generally have a life of more 

than one year, are acquired for use in the operation of the business, and are not intended for resale to 
customers. Assets differ from inventory items since you use them rather than sell them.  

 

Gain/Loss    

 The profit or loss resulting from the retirement of an asset.  
 

Intangible Asset    
 A long term asset with no physical substance, such as a patent, copyright, trademark, leasehold, and 

formula. Penn does not currently maintain intangible assets in BEN Assets. 
 

Location  
 A key flexfield combination specifying a particular place.  You assign each asset to a location. In BEN 

Assets, Location = Assignment .  Pennôs location flexfield include óBuilding, Floor and Roomô. 
 

Transaction Type    
 The kind of action performed on an asset. Transaction types include Addition, Adjustment, Transfer, and 

Retirement. 
 

Year -To-Date  Depreciation   
 The depreciation taken for an asset so far this fiscal year. 
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Logging on to BEN Financials   
 
From the U@Penn Portal Business Tab (http://medley.isc -seo.upenn.edu/penn_portal/u@penn.php)  

 Click on BEN Financials>BEN Financials Homepage or type  http://benapps.isc -seo.upenn.edu/  

F These are websites you may want to create a ñbookmarkò or ñfavoriteò in your web browser 

 
Included on this page is the following information:  

Across the Top  

 Contacts  ï takes you to information regarding BEN Helps and links to the Local Support Providers,  

Frequently Asked Questions, and the Financial Training Department 
 
 News  ï takes you to all the published communications regarding BEN 

 
 Related Links  ï takes you to the links for BEN Helps, Desktop Requirements and Setup, Hardware and 

Software Requirements, BEN Applications, Documentation, Training Information, Purchasing Services, 

Information Systems and Computing, Office of the Comptroller, and Office of the Vice President for 
Finance 

 

Along the Side  

 Access and Forms  ï takes you to the Document Forms Library which includes forms for BEN Reports, 

BEN Financials Printers, and Logon Request Forms 
 
 BEN Helps  ï takes you to the procedures for BEN Helps and includes a list of the 2 digit code for each 

School and Center 
 
 Desktop Requirements  ï takes you to the Hardware and Software requirements, installation  of the J-

Initiator plug -ins for Internet Explorer and installation of MarkView Web Client  
 
 Documentation  ï takes you to the documentation for BEN Balances, BEN Buys and BEN Reports 

 
 FAQ ï takes you to the óFrequently Asked Questionsô for all the BEN activities including BEN Helps, BEN 

Teaches, and General Usage 
 
 Training  ï takes you to the Financial Training Department homepage 

 
 Click on the BEN Financials  link to login to BEN Financials 

Check here for 
important 

system 

availability 
messages  

 

http://medley.isc-seo.upenn.edu/penn_portal/u@penn.php
http://benapps.isc-seo.upenn.edu/
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BEN Financials Login Window  

 
 Enter your application User Name  and Password  

 Click on [Connect]  or press [Enter]  

F You will see the message below if you enter an incorrect password or if you attempt to login when 
the system is unavailable (e.g. after 8:00 p.m. EST on weekdays).  

 

 If you forget your password, go to:  

Customer Service 

3401 Walnut Street, Suite 265B 

215-898-1099   

F Requires Penn ID 
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BEN Financials Homepage   

 

 When you click any one of the Responsibilities the system displays the navigation paths in the right 

panel for the selected responsibility. 

F Click on any of the responsibilities listed in the left panel and the navigation path for the responsibility 
automatically changes in the right panel.  

 
 

F The Navigator window appears on 

the screen.  To change a navigation 

path within a responsibility, invoke 

the Navigator by 

 Closing all forms or  

 Clicking on the óShow Navigatorô 

icon on the toolbar  

 



 

é.              Financial Training Department 12  

BEN Financials Responsibilities & Navigation Paths   

The BEN Financials Homepage lists the BEN Responsibilities for which you have access. Listed below each 

responsibility are the corresponding navigation paths. 

  
  

 
 

Senior Asset 
Administrator &  
Asset Administrator  
  

 Inquiry  
  Financial Transaction 

  Transaction History 

 Asset 
  Asset Workbench 

  Mass Changes 
 Other 

  Requests
   Run 

 Invoice Inquiry  

 

 
 
Budget Entry (Secured)      
 Budget Journal 
 

Freeze Grant (Secured)  
 Freeze Grant 
 View Grant Attributes 

 View User 
  

Freeze/Unfreeze Grant 
 (Secured)  
 Freeze Grant 

 View Grant Attributes 
 View User 
  

 
 
 
 
 
 

GL Inquiry (Secured)  
 Notifications
 Inquir y 

  Account 
  Funds Available 

  Journal 

  Rev/Exp Inquiry 
 Acct Mapping 

 Legacy GL to BEN 
 Legacy SL to BEN 

 Legacy Subcode to 
  BEN Object 

 Legacy Account Desc 

 Legacy Subcode Desc 
COA Inquiry 

 COA Segment Values 
 View Grant 

Attributes  

Other 
  Profile 

 View User 
 

GL Reporting (Secured)  
 Reporting 

  Run Report 

  Create Report Set 
 Other 

  Profile 
 

Journal Entry ï General  
 Notifications 

 Journals 
  Enter 

  Encumbrance 

 COA Inquiry 
 COA Segment Values 

 View Grant Attributes 
 Other  

  Profile  

View User 
 

 

 

 
 

 

PO Manager  
 Notifications 

 Purchase Orders 
  View/Control PO 

 Enter Receipts 
 Inquiry  

  Invoices 
  Locations 

  Receipts  

  Requisitions 
  Shipping Info 

  Suppliers 
 COA Inquiry

  

  COA Segment Values
  View Grant Attributes 

 Reporting 
  Run Report 

  Create Report Set 

 Other  
 Profile 

 View User 

  
Requisitioner  
 Requisitions Homepage 
 Suppliers 

 PO Action History 
 Shipment Information  

  
User Preferences  
 General Preferences 

 

 
 
 

BEN B alances   

BEN Assets   
BEN Buys  
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BEN Navigation ï Typical Application Window  

Top of Window  
 BEN Financials Application Window Bar 

  Window/Form Name 

   Menu Bar  
    Toolbar 

 

Bottom of Window  
 Message Block 

Record # Block  
   Available Features Block 

 
Other Window Features  

 Yellow - shaded fields indicate required data field(s) 

 Gray - shaded fields indicate currently unavailable data field(s)  

 White ï updatable but not required data field(s)  

 Blue ï shaded fields indicate query mode 
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Switching Responsibilities  

To switch Responsibilities 

 Close the current form by either  

 Clicking on the óxô in the upper right hand corner of the form or  

 Clicking on File>Close Form on the menu path or  

 Clicking on the óClose Formô icon on the Toolbar 

 Once the forms are closed 

 Click on File>Switch Responsibility or  

 Click on the óTop Hatô icon on the tool bar 

 This pop-up box wil l appear 

 

 

 
 
 
 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

Taskbar  
 
 You can also go back and forth between Responsibilities by using the óTask Barô on your desktop  

 

 

 
     U@Penn Portal  BEN Financials Homepage    Splash Screen         Application  
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Using  the Applications Na vigator Functions Region   

The forms that you can 

navigate to are displayed in a 
navigation list on th e left-hand 

side of the Navigator window. 
The navigation list is organized 

much like the hierarchy of a 

file system, where you can 
expand items that begin with a 

plus sign (+) to further sub -
levels until you find your form 

of interest. Sub-levels appear 

indented below the items from 
which they are expanded. 

Items that are expanded are 
preceded by a minus sign (-). 

You can expand no further 
when an item displays neither 

a plus or minus sign.  
 

Above the navigation list, you 

should see two fields that span 
the width of the window. 

These two fields help you 
identify your selection. The top 

field displays the name of the item currently selected, while the bottom field displays the choice 

highlighted.  

 

To expand or collapse the navigation list:  

 

 Choose one of the following methods to expand an expandable     item to its next sub -level: 

 Double-click on the item 

 Select the item and choose Open 

 Select the item and choose the Expand [+] button  

 

 Choose one of the following methods to collapse an expanded item: 

 Double-click on the item 

 Select the item and choose the Collapse [ - ] button  

 

 To expand or collapse several items at once, choose one of the following buttons:  

 Expand All Children--expand all the sub-levels of the  currently selected item  

 Expand All--expand all the sub-levels of all expandable items in the navigation list  

 Collapse All--collapses all currently expanded items in the navigation list  

 

 To open a form fr om the navigation list:  

 Select your form of interest  

 Choose Open 
 

 Alternatively, you can double-click directly on the form of interest to open it.  

 

F Do not double -click on the Open button.    All buttons require only a single click to activate.  
 
 

These are the 
options 
available from 
within the GL 
Inquiry 
responsibility 
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Using the Top Ten List  (Optional)  

 

If there are forms that you use frequently, you can copy them over to a navigation top ten list located on 

the right -hand side of the Application Functions Navigator. The top ten list displays your forms 

numerically so you can choose them instantly without having to drill down for them in the navigation list. 

You can add a maximum of ten forms to the top ten list and you can create a different top ten list for 

each responsibility you have access to. 

 

To create a navigational top ten list:  

 Highlight a frequently used form from the navigation list  

 Click on the arrow going right  

 The form name now appears in the navigation top ten list preceded by a top ten list number  

F If you wish to remove a form name from the top ten list, highlight t he form name in the top ten 
list and click on the arrow going left   
 

To open a form from the navigation top ten list:  

 Type the top ten list number that precedes the form name you want to open  

 You can also highlight the form name you want and click on [Open ], or double -click on the form 

name 

F The name and description of the form selected also appear in the current selection fields above 
the navigation list.  
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User Preferences  (Optional)  

 

 From the BEN Financials Homepage, click on User Preferences to change your password 

F Users will be prompted to change their password every 30 days.  User Preference is use to 
change when you desire. 
 

 Click on [Apply]  

 Click on  the             to return to the BEN Financials Homepage 
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Menu Paths  

 

Right Mouse Button Menus  
Depending on your desktop settings, using the right (or left) mouse button 

may allow you to access the following menu items:                           
 

 Cut 
 Copy 

 Paste  
 Folder Menu 

 Help 

 

Pull Down Menus  
 

 

Use the Pull Down menu bar to navigate through a form, to edit or retrieve data, or to perform various 
other actions. 

 

F Available functions show in black, while unavailable functions show as ñgrayed outò. 
 
File Menu  

 
The File menu lets you perform several actions in BEN Financials: 

 

 New  Opens a new record in the active form.  
  Open Opens the detail screen for the current selection.  

  Save Saves any pending changes in the active form.  
  Save and Proceed Saves any pending changes in the active form and 

advances to the next record.  

  Next Step Updates the Process workflow in the Navigator by 
advancing to the next step in the process.  

  Export Exports data retrieved.  
  Place on Navigator Creates an Icon in the Documents tab of the Navigator 

which can be used to recall the active form and its 
current record.  

  Log on as a Different User Exits the application and displays the BEN Financials 

Logon window.  
  Switch Responsibility  Displays the Applications Responsibility window.  

  Print   Prints your current window. An application may override 
this action to instead allow printing of one or more 

specific reports.  

 Close Form  Closes all windows of the current form.  
 Exit Oracle Applications Quits BEN Financials Applications. 
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Menu Paths  (continued)  
 

Pull Down Menus  (continued)  
 

 

F Available functions show in black, while unavailable functions show as ñgrayed outò. 
 

Edit Menu  

Use the Edit menu to edit your data in BEN Financials: 

 Undo Typing Undo any typing done in a field before the field is exited 
and returns the field to the most recent value.  

 Cut  Cut the current selection to the clipboard.  

 Copy Copy the current selection to the clipboard.  
  Paste Paste the contents of the clipboard into the current field.  

  Duplicate Record Above Copies all values from the prior record to the current 
record.  

  Duplicate Field Above Copies the value of the current field from the prior row.  
  Clear Record Erases the current record from the window.  

  Clear Field Clears the data from the current field.  

 Clear Block Erases all records from the current block.  
  Clear Form Erases any pending changes from the current form.  

  Delete Deletes the current record from the database.  
  Select All Selects all records (for blocks with multi-select).  

 Deselect All Deselects all selected records except for the current 

record (for blocks with multi -select).  
  Edit Field   Displays the Editor window for the current field.  

  Preferences Change Password Displays the Change Password dialog box.  
  Preferences Profiles Displays the Profiles window. 

  
View Menu  

The View menu provides you with the following options:  

 Show Navigator  Displays the Navigator window.  

 Zoom  Invokes custom defined zooms.  
 Find   Displays the Find window to retrieve records.  

 Find All  Retrieves all records.  
 Query by Example Enter  Invokes 'Enter Query' mode to enter search criteria for a  

                                  query-by-example.  
 Query by Example Run  Executes the query-by-example.  

 Query by Example Cancel  Cancels the query-by-example by exiting from 'Enter 

Query' mode.  
 Query by Example Show Last Criteria  Recovers the search criteria used in the previous query- 

by-example.  
 Query by Example Count Matching Records Counts the number of records that would be retrieved if      

you ran the current query -by-example.  

 Record First  Moves the cursor to the first record.  
 Record Last  Moves the cursor to the last record.  

 Translations   Displays the Translations window.  
 Attachments   Displays the Attachments window.  

 Summary/Detail  Switch between the summary and detail views of a 

combination block.  
 Requests  Displays the Request window.  Requests are your 

reports. 
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Menu Paths (continued)  

 

Pull Down Menus  (continued)  

  
 

F Available functions show in black, while unavailable functions show as ñgrayed outò. 
 

Folder Menu  

The Folder menu lets you customize the presentation of data in a folder:  

New Creates a new folder definition.  
Open  Opens an existing folder definition.  

Save (Do Not Use ï Saves Query) Saves changes to the current folder definition.  

Save As (Use ï Doesnôt Save Query) Saves current folder definition to a new name.  

Delete  Deletes an existing folder definition.  
Show Field  Displays a field that is currently hidden.  

Hide Field  Hides the current field.  

Move Right  Moves the current field to the right.  
Move Left  Moves the current field to the left.  

Move Up  Moves the current field up.  
Move Down  Moves the current field down.  

Widen Field  Increases the width of the current field.  

Shrink Field  Decreases the width of the current field.  
Change Prompt  Changes the prompt for the current field.  

Autosize All Adjusts all field widths to completely show their data.  
Sort Data  Specifies sort order for the first three fields by 

ascending, descending and no ordering.  

 View Query  Displays the query criteria for the current fold er 
definition.  

 Reset Query  Erase the current query criteria.  
 Folder Tools   Display the folder tool palette.  

 

Tools Menu  
The functions in the Tools menu differ based on the area of Responsibility in which you are currently 

working.  Available functions show in black, while unavailable functions show as ñgrayed outò. 

 

Window Menu  

The Window menu displays the names of all open application windows and window placement options. 

 
 Cascade Displays any open windows in a "cascaded" or stair-

stepped fashion. 
 Tile Horizontally Displays any open windows in a horizontally "tiled" 

   (non-overlapping) fashion. 
 Tile Vertically Displays any open windows in a vertically "tiled"  

   (non-overlapping) fashion. 

 Open Window List   Displays a list of open window titles in the order in which 
they are stacked.  
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Menu Paths (continued)  

 

Pull Down Menus  (continued)  

 

 

F Available functions show in black, while unavailable functions show as ñgrayed outò. 
 

Help Menu  

Use the Help menu to get additional information about BEN Financials: 

Window Help  Displays help for the current window.  

Oracle Applications Library   Displays a window that lists all available Oracle 

Applications help text.  
Keyboard Help   Displays the current key mappings of specific functions 

and menu options. 
Diagnostics  Used for technical diagnostics.  

Record History  Displays information about the current record.  

About Oracle Applications   Displays information about the current window and 
application, including version information.  
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Toolbar   

 

 
Collection of iconic buttons  replicating commonly-used menu selections. Depending on the context of the 

current field or window, a toolbar button will be either enabled or disabled. You can display the label for 
an enabled toolbar button by holding your mouse ov er the button.  The toolbar buttons and the actions 

they perform are as follows:  
 

New - Opens a new record in the active form.  

Find - Displays the Find window to retrieve records.  

Show Navigator ï Displays the Navigator window. 

Save - Saves any pending changes in the active form.  

Next Step - Disabled in BEN Financials. 

         Top Hat ï Enables switching Responsibilities.  

Print - Prints the current screen that the cursor is in, i.e. the óprint screenô function. 

Close Form - Closes all windows of the current form.   

Cut - Cut the current selection to the clipboard.  

Copy - Copies current selection to the clipboard.  

Paste - Pastes from the clipboard into the current field.  

Clear Record - Erases the current record from the window.  

Delete ï Deletes the current record from the database.  

          Edit Field - Displays the Editor window for the current field.  

                  Zoom ï Get Next Invoice Image (typically used by Accounts Payable)  

 Translations - Invokes the Translations window.  

 Attachments - Invokes the Attachments window. If one or more attachments already  

 exist, the icon changes to a paper clip on a piece of paper.  

Folder Tools - Displays the folder tool palette.  

Window Help - Displays help for the current window.  
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Keyb oard Shortcuts  
 

Although these functions can be accessed either by the toolbar or pull down menus, Keyboard Shortcuts 
are yet another option for navigating through BEN.  

   
Block menu  [Ctrl] [B]  

Clear Block [F7]  

Clear Field [F5]  

Clear Form [F8]  

Clear Record [F6]  

Commit [Ctrl] [S]  

Count Query [F12] 

Delete Record [Ctrl] Up Arrow  

Display Error [Shift] [Ctrl] [E]  

Duplicate Field [Shift] [F5]  

Duplicate Record [Shift] [F6]  

Edit [Ctrl] [E]  

Enter Query [F11] 

Execute Query [Ctrl] [F11]  

Exit [F4]  

Help [Ctrl] [H]  

Insert Record [Ctrl] Down Arrow  

List of Values [Ctrl] [L]  

List Tab Pages [F2]  

Next Block [Shift] [Page Down]  

Next Field [Tab]  

Next Primary Key [Shift] [F7]  

Next Record Down Arrow 

Next Set of Records [Shift] [F8]  

Previous Block [Shift] [Page Up]  

Previous Field [Shift] [Tab]  

Previous Record Up Arrow 

Print [Ctrl] [P]  

Return [Enter]  

Scroll Down [Page Down] 

Scroll Up [Page Up] 

Show Keys [Ctrl] [K]  

Update Record [Ctrl] [U]  
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Navigation Tips   

Item  BEN Financials  
 

Navigating Pull Down Menu Paths; Toolbar icons; Keyboard shortcuts 
 

Quickpick List of Value icon [···]  within field or [Ctrl] L  

 
Cancel Runaway Query Pop-up box appears after first 100 records.  Click [Continue], [Stop] 

or [Continue to End] or Click [Cancel] on óPress Canceléô message. 
  

Change Responsibility File>Switch Responsibility 

 
Move From Fields and Zones  [Tab] or Move Cursor With Mouse 

 
Finding Patterns With Wildcards You can use the percent '%' wildcard within a field to represent any 

 number of characters (including no characters).  

 
 Example: To retrieve all records that contain the word "Central" in a 

 specific field, you would enter %Central% in that field.  Click [Find] . 
 

Case Sensitive? Yes 
 

Message and Status Lines Bottom of Window 

 
Available Options Toolbars & Menu Items 

 
Record History Help>Record History  

 

Name in Action History View User option listed under various Responsibilities 
 

Enter Query View>Query By Example>Enter  or [F11]  or Flashlight Icon 
 

Execute Query View>Query By Example>Run or [Ctrl] F11 or click [Find]  
 

Cancel Query View>Query By Example>Cancel of [F4]  

 
Copy Field Edit>Duplicate>Field Above or [Shift] [F5]  

 
Copy Record Edit>Duplicate>Record Above or [Shift] [F6]  

 

Paste Edit>Paste 
 

Error Message Pop-up Box 
 

Report Requests 

 
Additional Record Information Pop-up List or [é]  

 
Insert  Row [Ctrl] Down Arrow  or NEW record icon 

 
Field Edit Edit>Edit Field 

 

Exiting File>Exit Oracle Applications 
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Additional Tips  
Canceling a Long Running Query  

 

When a query may take longer than a few seconds to retrieve the selected records, this pop -up message 

may appear.  Ignore this message if you wish to wait for the query to finish.  Or click on [Cancel] to end 
the query and either enter data to narrow the search or re -enter any mistyped information.  

 

 

Canceling a Query with Many Records  
 

If you enter  a query and the records exceed 100, you will see this message appear.  Select from the 

following options:  

 [Continue] - will continue to the next 100 records  

 [Stop] - will stop the query  

 [Continue to End] - will continue to the end of the entire query  

 

Server Not Available  
 
The pop-up box below will appear when a server connection is unavailable, e.g. due to hardware or 

network problems.  Click [OK] to remove message. 
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Exporting BEN Financials Data to a Microsoft Excel Spreadsheet  

 

Procedure  

 From the menu, click on File>Export  

 If your desktop is configured properly, you should either see the spreadsheet or the following box, 

which should say Opening: filename using EXCEL.EXE.  If it does not say EXCEL.EXE, your desktop 

is not configured properly (see below). 

 

 

 

 

 

 

 

 

 

 

 

 

 Select Open It  and click [OK]  

Desktop Configuration  

 Should be handled by your Local Support Provider (LSP) 

 Do-it-yourself instructions can be found here: 

http://www.finance.upenn.edu/ben/benfin/desktop_req/config -excel.shtml  

F If your desktop is not configured properly, you will receive the following box.  You can either 
select Pick Appé and browse to the EXCEL.EXE file on your hard drive, or select Save Fileé and 
open the file from within Excel later.  

 

 

 

 

 

 

http://www.finance.upenn.edu/ben/benfin/desktop_req/config-excel.shtml
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Using the Navigator's Documents Region   

 
If you have a document, such as a particular purchase order, invoice, or report that you want to access 

later, you can create a link to the document using t he Navigator's Document feature. The Navigator's 

Document feature allows you to create as many links as you want and save them in the Documents 

region of the Navigator window. The links can be represented as icons in the window or may be viewed 

as a list. When you use a link to open a document, BEN Financials opens the document in the appropriate 

form window. You can access the Document region using the tab titled óDocumentsô.  

Adding New Documents to the Navigator  

 Forms that support adding documents to the  Navigator enable the Place on Navigator  menu item 

in the File menu.  Use this menu item to add your document to the Navigator.  

Opening the Navigator's Document Region  

 Click on the Documents  tab in the Navigator window  

To Open a Form from the Document Reg ion  

 Select the document link you want to open  

 Click on [Open]  or double-click on it  

Renaming Documents in the Navigator  

 Highlight the document link you want to rename.  

 Click on [Rename]  or double-click on the label 

 Enter the new name, then 

click [OK]  

F There is a limit of 80 
characters for document 
names 

 

Removing Documents from 
the Navigator  

 

 Highlight the document link 
to be discarded 

 

 Click on [Remove]  

F Documents placed on 
the Navigator will stay 
there until you remove 
them. 

Removing the document 

link fr om the Navigator has 

no effect on the actual document. However, if a record such as a report request is deleted, 

the link in your Navigator displays a message letting you know that your link is now invalid.  

Label  

F Once you create a link 
to a document, the 

Document region will open 

by default when you log on.  
Information here is 

static, i.e. not updated.  
 



 

é.              Financial Training Department 28  

Logging Off of BEN Financials  
 
When you are ready to logoff of BEN Financials 
 

 Close all the open windows and forms by clicking on the óxô in the upper right hand side 

 Click on File>Exit Oracle Applications  

 Click [OK]  
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BEN Assets   
 
In Pennôs decentralized environment, Schools and Centers are responsible for property management.  

BEN Assets enhances existing asset management tools and processes to support the Schools and Centers 

in improving their operational efficiency and safeguarding University assets.  

The new BEN Assets application and processes promotes: 

Á Improved oversight and control over moveable equipment assets to avoid loss and/or unauthorized 

disposal 

Á Trusteesô confidence regarding managementôs ability to appropriately safeguard University assets  

Á Improved processing through better integrat ion with other systems, reduction in manual processing, 

and greater transparency of equipment information for C ustodians 

Á Greater indirect cost recovery from research by more accurately linking  research equipment with 

specific rooms     

What is an Asset?  

 
An asset is any item for which all three of these criteria apply: 

Á Item has a value of $5,000  or higher  

Á Item has a useful life  of more than one year  

Á The University  retains title of the item  

BEN Assets ï Policy Overview  
 

 Custodians must safeguard University assets 

 The University must maintain accurate records of tangible property whose value and useful life meet 

the criteria of a capital or property asset  

 Schools & Centers have the responsibility for managing their assets within all applicable regulations 

and policies 

 Property assets are required to be tagged, maintained and periodically inventoried 
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BEN Assets Roles  

 
Property Management Group (PMG)  

 
This central University group has oversight responsibility for ensuring that policies and procedures related 

to the stewardship and maintenance of records for University assets are followed.   This includes 

developing and promulgating fixed asset policies and procedures.  PMG is also responsible for reviewing 
and adding assets acquired into the BEN Assets system, reconciliation of BEN Assets to the general 

ledger, and planning and coordinating inventory activities.  
 

 

Senior Asset Administrator (SAA)   
 

The SAA has responsibility at the School/Center level for ensuring that policies and procedures related to 
the stewardship of the assets and the maintenance of fixed asset records are followed.  The SAA is 

responsible for the following:  
 Ensuring all their assets are appropriately capitalized and entered into BEN Assets 

 Verifying that all their assets are tagged or i dentified as untaggable 

 Coordinating with PMG the inventory of his/her School/Center  

 Following up on any items that could not be located during the inventory process  

 Recording their authorized disposals in BEN Assets 

 

The SAA is also responsible for assigning personnel to the appropriate roles within the School/Center, 

such as Asset Administrator, Tagging Contact, Custodian, to assist him/her with these stewardship and 
record maintenance responsibilities and for ensuring that said Asset Administrators, Tagging Contacts and 

Custodians carry out their duties appropriately.  The SAA is generally the Senior Business Administrator or 
his/her designee. 

 

 
Asset Administrator (AA)  

 
The Asset Administrator has responsibility for the overall management of informatio n into the BEN Assets 

system for existing assets, including updates for descriptive information, as well as changes in location, 
responsible ORGs, Custodians, Tagging Contacts, and other changes of which he/she is notified by the 

Tagging Contact, Custodian or other responsible persons.  In addition the Asset Administrator is 

responsible for running the necessary reports in BEN Assets, BEN Reports or against the Data Warehouse 
as required.   

 
 

Tagging Contact (TC)  

 
The Tagging Contact is responsible for affixing the actual property tags on moveable equipment under 

his/her purview or for determining that equipment is not taggable as well as for notifying the AA of the 
tag number assigned to the asset or that the asset should be identified as untaggable.  The T C is also 

responsible for verifying from a printed report the information in BEN Assets is correct with regard to the 

asset at the time of tagging and for notifying the AA of any changes.   The TC is also responsible for 
assisting with asset location during inventories. 
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BEN Asset Roles (continued)  
 
Custodian  

 
The Custodian has primary responsibility for the stewardship and safeguarding of assets to which he/she 

is assigned.  The Custodian is responsible for reporting any relocation or transfer of assets under his/her 

care to the AA for updating this information in BEN Assets.  The Custodian is responsible for initiating the 
retirement process for any assets retired (including theft or casualty loss).  The Custodian is also 

responsible for assisting with asset location during inventories.  Each Custodian is responsible for 
maintaining a list of assets in his/her care.   

 

 
Buyer  

 
When purchasing equipment, the Buyer is the PO Manager who first approves the requisition from which 

the purchase order is generated.  The Buyer is also responsible for selecting the appropriate asset object 
code (see below) to charge for the asset purchased and for determining and entering the required 

property information into the property management form (pop -up box) when creating a requisition in 

Internet Procurement (IP).  The buyer is also responsible for acquiring an Asset Number for purchases 
that are a component of an Equipment In Process. 

 
 

PO Manager  -  Approver  

 
The PO Manager (can also be the Buyer) is responsible for verifying that the object code is correct and 

that all required property information has been entered correctly prior to approving the requisition.  
 

Note:  The responsibilities identified here relate only to that information required for fixed asset 
acquisitions which meet the Universityôs capitalization policy and not to the requisition process as 
a whole. 
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The Life of an Asset  
 
An asset in the majority of cases becomes an asset via of the creation of a requisition, whereby the 

following asset object codes are selected:  

 1870 Furniture and Fixtures (previously 1830) 

 1871 Computer Equipment (previously 1831) 

 1872 Other Capitalized Equipment (previously 1832) 

 1877 Equipment in Process (previously 1834) 

 1874 Rare Books, Artwork and Collectibles (previously 1850-1852, and 1859) 

 

Upon selection of one these object codes the Property Management form in the requisition is triggered 

which requires the óBuyerô to enter additional information applicable to the asset.   

When the invoice for the asset is processed by Accounts Payable, this begins the óLife of an Assetô as 

illustrated below:  

 

Life of an AssetLife of an Asset

AP AP 

Invoice Invoice 

over over 

$5,000$5,000

Automated AdditionAutomated Addition Manual Addition by PMGManual Addition by PMG

Cost AdjustmentCost Adjustment
Location ChangesLocation Changes

Retirements Retirements 
SAA & PMG SAA & PMG 

onlyonly
Reports Reports 

Monthly Monthly 

DepreciationDepreciation

Inquiry/  Inquiry/  
UpdatesUpdates



 

é.              Financial Training Department 33  

BEN Assets Business Processes & Procedures  

Acquisitions -  Assets Purchased via BEN Buys   

 
Overview  

 
     This procedure describes the types of assets (property) and the associated property information 

required to be entered by the Buyer at the time a requisition is created for equipment assets purchased 
at the University of Pennsylvania.  When the invoice for the respective Purchase Order (P.O.) is processed 

by Accounts Payable (A/P) this property information is automatically transferred into the BEN Assets 

system.   
     This information is necessary for the proper identification, tracking, maintenance and inventory of the 

asset once it is acquired.  
 

Responsibilities:  

 
Schools/Centers 

 
PO Manager/Buyer ï When purchasing equipment, the Buyer is responsible for selecting the appropriate 

asset object code (see below) to charge for the asset purchased and for determining and entering the 
required property information into the property man agement form (pop -up box) when creating a 

requisition in Internet Procurement (IP) also known as BEN Buys. 

 
PO Manager/Approver ï The PO Manager (can also be the Buyer) is responsible for verifying that the 

object code is correct and that all required prop erty information has been entered correctly prior to 
approving the requisition.  

 

Note:  The responsibilities identified here relate only to that information required for fixed asset 
acquisitions which meet the Universityôs capitalization policy and not to the requisition process as 
a whole. 
 

Property Management Group (PMG) 

 
PMG is responsible for reviewing the invoice transactions from Accounts Payable (A/P) for the purchase of 

assets and adding these assets to the BEN Assets System.  PMG is also responsible for reconciling 
additions between BEN Assets and the General Ledger (G/L), for reconciling assets pending in the Mass 

Additions Workbench to the clearing account in the G/L and for monitoring and aging assets that are 
pending in the Mass Additions Workbench. 
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BEN Assets Business Processes & Procedures  (continued)  
 

Acquisitions -  Assets Purchased via BEN Buys (continued)  
 
Definitions  
 

1. Equipment  to be capitalized refers to an item of non -expendable tangible personal property with a 
useful life of more than  one year, a cost in excess of $5,000 per item, excluding freight charges and 

taxes, and for which the University has title.  Equipment may be moveable or fixed.  Below are the 

various types of equipment that may be purchased at the University of Pennsylvania: 
 

2. Moveable Equipment  refers to equipment which can be easily moved from one area to another 
and includes items such as furniture, lab equipment, computers, software (other than major 

systems), etc.   

 
Moveable Equipment should be purchased using the appropriate Moveable Equipment object code: 

 
1870  Furniture and Fixtures  

1871  Computer Equipment  
1872  Other Capitalized Equipment  

 

3. Equipment in Process (EIP)  refers to costs incurred for fabricating non -expendable, tangible 
personal property that  is not available elsewhere, by physically combining or assembling modular 

components and/or materials into one identifiable unit . This equipment is considered EIP until the 
equipment is completed and placed in service.  The following do not qualify as EIP:  

 

 Costs incurred for standard items that are altered or customized to make them usable on a 

project.   
 Items that are added to replace existing components or upgrade the asset are not components 

and should be expensed rather than added to cost of the existing asset. 

 
Before ordering components to be used in fabricating a piece of equipment, the Buyer should contact 

PMG to have  an asset number assigned to the fabricated equipment to which all component costs 

will be accumulated as the acquisition cost of the asset.  To assign the asset number, PMG will need 
to create an in-process asset within BEN Assets and as such will need to input the required property 

information related to the equipment being fabricated.  
 

EIP components should be purchased using the 1877  Equipment in Process object code. 
 

4. Collectibles  - Rare books, museum collectibles and artwork acquisitions are capitalized at cost plus 

associated expenses.   Rare books and other collectibles are not depreciated.   
 

Collectibles should be purchased using the 1874 Rare Books, Artwork and Collectibles object code. 
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BEN Assets Business Processes & Procedures  (continued)  
 

Acquisitions -  Assets Purchased via BEN Buys (continued)  
 

Business Procedure  
 

Requisition of Equipment 
 

1. For the purchase of equipment and collectibles via the Universityôs Internet Procurement system, 

certain object codes must be used to activate the property management form to allow the Buyer to 
add the additional information required for recording , tracking and depreciating such assets in the 

Universityôs fixed asset system - BEN Assets.  These object codes are: 
 

 1870 Furniture and Fixtures (previously 1830) 

 1871 Computer Equipment (previously 1831) 

 1872 Other Capitalized Equipment (previously 1832) 

 1877 Equipment in Process (previously 1834) 

 1874 Rare Books, Artwork and Collectibles (previously 1850-1852, and 1859) 

 

2. The Buyer, when preparing a requisition that uses any of the above listed object codes will be 
required to input the following information in the property management form (pop -up box: 

 

a. Description -  Defaults from the Penn Marketplace.  For equipment items ordered on a Non-
catalog requisition, the Description must include an English language description of the item 

including the Manufacturerôs name and Model# if available. 

 
b.  BLDG-FLR-RM ï This is the building, floor and room where the asset will be located upon 

installation.  This information can be selected from a List of Values (LOV) and will be 
validated against existing building/floor/room combinations in the Facilities Center databa se. 

This is a required field.  

  
c. Category Code  ï This is the code that best describes the equipment purchased (e.g., Office 

& Lab Furniture, Scientific Equipment, Computer Equipment, etc.).  The Category Code is 
used to determine the useful life of the asse t over which it will be depreciated.  Although the 

default is set to a null value, an actual category must be selected from the LOV.  This is a 
required field . 

 

d. Responsible Organization  ï This represents the 4-digit ORG that owns or is responsible 
for safeguarding of the asset.  This information defaults from the first line of the Purchase 

Order (PO) but can be modified by the Buyer from the LOV.  This is a required field.  
 

e. Govt. Retain Title? Y/N  ï ñYò should be selected if ownership of the asset remains with 

the government agency that funds the acquisition of the asset; otherwise ñNò should be 
selected.  This is a required field.  

 
Please note :  If the government retains title (Y), the acquisition cost of the 

asset should not be capitalized using the 187x o bject code, but instead 

should be expensed to the appropriate 5xxx object code.  
 

f. Custodian of Item  ï This is the person within the organization who primarily uses or has 
primary responsibility for safeguarding the asset.  The Buyer should select the Custodian 

from the LOV which shows the full name and Penn ID of University employees.  This is a 
required field.  
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BEN Assets Business Processes & Procedures  (continued)  
 

Acquisitions -  Assets Purchased via BEN Buys (continued)  
 

g. Custodian Phone  ï This is the telephone number of the Custodian identified above.  This is 
a free-form field which requires the Buyer to enter in the telephone number.  The phone 

number should be at least 12 characters long, including ñïósò, and should be formatted as 
follows: ### -### -####  x##, including area code and extension, if applicable.  This is a 

required field.  

 
h. Tagging Contact  ï This is the person responsible for physically tagging the asset (or, 

alternatively determining that the item is untaggable) and responsible for verifying the 
information in BEN Assets once the asset has been entered into the system.  The Buyer 

should select the Tagging Contact from the LOV which shows the full name and Penn ID of 

University employees.  This is a required field.   
 

i. Tagging Contact Phone  - This is the telephone number of the Tagging Contact identified 
above.  This is a free-form field which requires the Buyer to enter in the telephone number.  

The phone number should be at least 12 characters long, including ñïósò, and should be 
formatted as f ollows: ### -### -#### x##, including area code and extension, if 

applicable This is a required field.  

 
j.  Component of Existing Asset? Y/N  ï Where the item purchased is to be added as a 

component to an existing asset, the Buyer should select ñYò; otherwise the Buyer should 
select ñNò.  This is most often used in instances where the University is fabricating equipment 

(Equipment in Process) and the components of the main asset are purchased separately.  

This is a required field.  
 

Please note:  Where the Buyer is purchasing components, an asset must already be set 
up in BEN Assets to accumulate the costs of the various components into one asset.  This 

will require the Buyer to contact the PMG in advance when a new piece of fabricated 

equipment is going to be constructed to set up the asset in the BEN Asset system and 
have an asset number assigned. See section on EIP below for how to have an asset 

number assigned. 
 

k. Primary Asset Number  ï When the answer to ñComponent of Existing Asset? Y/Nò is ñYò, 
the Buyer must enter the asset number in this field of which the item being purchased is a 

component.  The Asset Number will be validated against existing assets in BEN Assets.  This 

is a required field if the answer to the Component field is equal to ñYò. 
 

Equipment in Process (EIP) 
 

1. EIP assets are equipment that is fabricated by the University.  While the equipment fabrication is still 

in process, the costs of components or materials for the final or ñprimaryò asset will be accumulated 
in BEN Assets in an ñin processò status and will not be depreciated until the asset is completed and 

placed in service. 
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BEN Assets Business Processes & Procedures  (continued)  
 

Acquisitions -  Assets Purchased via BEN Buys (continued)  
 

2. The School/Center must request PMG to set up the EIP asset in BEN Assets prior to purchasing 
components for the asset.  To do this, the School/Center must contact PMG and using the 

ñEquipment Information Formò available on the PMG website provide the following information: 
 

 Description (standard English language description that will be used to identify the asset to 

the School/Center responsible for the asset) 

 Installation Location ï Building/Floor/Room (must be a valid location in SPACE) 

 Category Code of the finished asset 

 Responsible  ORG (the 4-digit ORG that owns or is responsible for safeguarding of the asset) 

 Does the Govôt Retain Title? Y/N ï if the government does retain title, costs of the fabricated 

asset should be expensed 
 Custodian  

 Custodian Phone number, formatted as follows: ### -### -#### x##, includ ing area code 

and extension, if applicable 

 Tagging Contact 

 Tagging Contact Phone number, formatted as follows: ### -### -#### x##, including area 

code and extension, if applicable 
 Expected in-service date (this is an estimate and will be entered into BEN Assets for 

informational purposes only; assets will not be depreciated until PMG is notified that the 

asset has been placed in service and PMG changes the status of the asset from ñin-processò 
to ñcapitalizedò, at which time the in-service date will be updated to reflect the true in -service 

date) 

 
3. Once the School/Center has provided the information above to PMG, PMG will create the in-process 

asset in BEN Assets, which will then assign the asset an Asset Number.  PMG will forward the Asset 
Number to the requestor (usually the Buyer) in the School/Center.  This Asset Number should be 

entered into the property management form (pop -up box) by the Buyer in the field ñPrimary Asset 

Numberò for any and all components purchased for the equipment item to be fabricated.  The 
ñPrimary Asset Numberò field only becomes active when the question ñComponent of Existing Asset?ò 

has a ñYò response.   
 

4. It is the School/Centerôs responsibility to ensure that costs are properly identified and accumulated 

for each item of fabricated  equipment.  On a monthly basis the Schools and Centers with EIP must 
review their in -process equipment assets to ensure that all costs have been captured in the 

acquisition cost for the assets.  This review should also identify any assets that have been or will be 
placed in service or to identify in -process assets that were retired before being placed in service. 

 
5. Once the asset has been placed in service, the School/Center must notify PMG of the change in 

status and the in-service date.  Upon such notification, PMG will change the status of the asset from 

ñin-processò to ñcapitalizedò and update the date in service.  This will start the depreciation process 
of the asset.  If the asset is disposed of without having been placed in service, the School/Center 

should notify PMG of such disposal.  The School/Center should expense the acquisition cost of the 
asset by debiting expense (5225 or 5224) and crediting the 1877 Equipment in Process object code. 

PMG will then record the adjustment to the cost in BEN Assets and retire the asset.  
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BEN Assets Business Processes & Procedures  (continued)  
 

Acquisitions -  Assets Purchased via BEN Buys (continued)  
 

Addition of Equipment to BEN Assets  
 

1. Once the equipment has been received and the invoice from the vendor has been processed by A/P, 

the equipment charge will be posted to the G/L by A/P.  For any transactions posted by A/P to the 

asset clearing accounts (object codes 187X), A/P will transfer the P.O. and invoice information, 
including the information from the property  form in the original requisition, to BEN Assets.  Once this 

information transfer is made, the equipment information is available to be viewed by PMG in BEN 
Assets in the Mass Additions Workbench.  

 

2. On a daily basis PMG will review the items in the Mass Additions Workbench of BEN Assets.  

 

a. PMG will review the ñFA - Purchase Orders Existing in BEN Assetsò standard Business Objects 
query to identify invoices that need to be added to existing assets.  PMG will then add these 

costs to existing assets using the ñAdd to Assetò button. 
 

b. PMG will review of the purchase order/invoice to determine if the asset needs to be merged 

with another invoice; to determine if the invoice is for multiple units that need to be split into 
multiple assets; and/or to determine if th ere are costs that do not qualify for capitalization.  

 
3.  PMG will also review the amount of funding for any asset purchased with grant funds.  The ñResearch 

Amountò field is automatically populated with the 
invoice line amount for any invoice line with an 

invoice distribution to a 5xxxxx fund.  If the 

invoice line represents a cost adjustment, or 
component that is to be added to an existing 

asset, then PMG will notate the amount of grant 
funding and then add this amount to the amount 

in the ñResearch Amountò descriptive flex field of 

the primary asset.   
 

Please note:  For any assets that are merged or split, (See 

Appendix B Asset with Single PO/Invoice and Multiple 

Distributions (Clearing Accounts) and Asset with Single PO/Invoice and Multiple Assets) PMG must determine 

the amount of grant funding to be combined from the merged assets or to be distributed among the split asset(s) 

and add this amount to the appropriate asset(s) after they have been created by the ñPost Mass Additionsò 

process. 
 

a. PMG will review any items that have been identified as a component of an existing asset and 

will add that component to the asset number identified in the ñPrimary Asset Numberò 

descriptive flex field using the ñAdd to Assetò button. 
 

b. PMG will review any items that have the descriptive flex field ñDoes Govôt Retain Title?ò 

marked as ñYò and follow up with the School/Center purchasing the equipment to ensure that 

if the University does not retain title to the equipment, the costs are expensed.  It is the 
School/Centerôs responsibility to record the entry to expense the costs and clear the clearing 

account. 

 
 

c. PMG will verify that the following information has been completed for each asset:  
 Category Code 

 Location 

 Description 

 Custodian 

 Custodian Phone # 

 Tagging Contact 

 Tagging Contact Phone # 

 Responsible ORG 
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d. If any information is missing or has become invalid since the requisition was created, PMG 
must contact th e TC or Custodian at the School/Center to obtain the missing information.  

 
4. Once PMG has completed its review of the asset in the Mass Additions Workbench and the item is 

ready to be made an asset, PMG will change the ñQueueò field of the item to ñPostò.   

 
5.  Periodically, but at least once a day, PMG will then run the Create Mass Additions process 

to post  the assets.  Once the asset has been created, it can be viewed and updated in 
BEN Assets by the Schools/Centers.  Because the Data Warehouse is updated nigh tly, the 

asset will not be available for reporting in the Data Warehouse until the day after it has 

been created in BEN Assets.  
 

6. BEN Assets will create journals to transfer the acquisition cost for assets created from the Clearing 
Account (187X) to the Cost Account (182X).  These entries will be posted to the G/L at the end of 

each month when depreciation is run and the current period in BEN Assets is closed. 
 

Returns of Assets for Credit  

 
1. When an asset is returned to the vendor a credit memo may be issued by the vendor for the return.  

This credit is processed by Accounts Payable (A/P) against the asset clearing account (1870, 1871 or 
1872) which incurred the original charge.   

2. Once the credit from the vendor has been processed by A/P, the credit will be po sted to the G/L by 

A/P.  For any transactions posted by A/P to the asset clearing accounts (object codes 187x), A/P will 
also transfer the P.O. and invoice information, including the information from the property form in 

the original requisition, to BEN Assets.  Once this information transfer is made, the equipment 
acquisition information is available to be viewed by PMG in BEN Assets in the Mass Additions 

Workbench. 

3. On a daily basis PMG will review the items in the Mass Additions Workbench of BEN Assets.  
 

a. PMG will review the ñFA ï Purchase Orders Existing in BEN Assetsò standard query in 
Business Objects to identify credits that need to be applied to existing assets.  PMG will then 

add these credits to existing assets using the ñAdd to Assetò button. 
 

b. PMG will review of the purchase order/invoice to determine if the credit needs to be merged 

with another invoice; to determine if the credit needs to be split among multiple assets; 
and/or to determine if the credit relates to costs that did not qualify for ca pitalization. 

 
c. PMG will also review the amount of funding for any asset purchased with grant funds.  The 

ñResearch Amountò field is automatically populated for any credit invoice line with an invoice 

distribution to a 5xxxxx fund with the credit invoice li ne amount.  If the invoice line 
represents a cost adjustment or credit, then PMG will notate the amount of grant funding 

and then reduce the amount the amount in the ñResearch Amountò descriptive flex field of 
the primary asset by this amount.   

 
Please note:  For any credits that are merged or split, PMG must determine the amount 
of grant funding to be combined from the merged credits or to be distributed among the 
split asset(s) and apply this credit amount to the appropriate asset(s) after they have 
been created by the ñPost Mass Additionsò process. 
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d. PMG will review any credits for items that have been identified as a component of an existing  
asset and will apply that credit to the asset number identified in the ñPrimary Asset Numberò 

descriptive flex field using the ñAdd to Assetò button. 
 

e. PMG will review any items that have the descriptive flex field ñDoes Govôt Retain Title?ò 

marked as ñYò and follow up with the School/Center purchasing the equipment to ensure that 
if the University does not retain title to the equipment, the costs are expensed.  It is the 

School/Centerôs responsibility to record the entry to credit the expense account and clear the 
clearing account. 

 

4. Once PMG has completed its review of the asset in the Mass Additions Workbench and the item is 
ready to be made an asset, PMG will change the ñQueueò field of the item to ñPostò.   

 
5. Periodically, but at least once a day, PMG will then run the Create Mass Additions process to post the 

assets.  Once the asset has been adjusted, the adjustment can be viewed in BEN Assets by the 
Schools/Centers.  Because the Data Warehouse is updated nightly, the adjustment will not be 

available for reporting in the Data Warehouse until the day after it has been created in BEN Assets. 

 
6. BEN Assets will create journals to transfer the credit for any asset whose cost is adjusted from the 

Clearing Account (187x) to the Cost Account (1821), reducing the asset cost.  These entries will be 
posted to the G/L at the end of each month when depreciation is run and the current period in BEN 

Assets is closed. 

 
7. On occasion, the refund may be less than the acquisition cost of the asset.  In these instances, the 

School/Center that owned the asset should prepare a manual journal entry to charge (debit) expense 
(5224 Non-Capitalized Computer Equipment & Peripherals or 5225 Other Non-Capitalized 

Furniture/Removable Fixtures/Equipment) and reduce (credit) the asset clearing account (1871 

Moveable Equipment object code) for the difference between the acquisition cost of the asset and the 
amount of the refund.  PMG will then make an additional cost adjustment to reduce the acquisition 

cost of the asset to zero since the University no longer owns the asset.  PMG will also maintain 
documentation of the cost adjustment, including authorization for the cost adjustment.  See PP&E 

Procedure ñAcquisitions:  Manual Journal Entries to Clearing Accounts, Returns, Cash Refunds for 
Returns of Assets and Trade-insò for more details.  
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Overview  

 
To describe the procedure for capitalizing construction projects once they are substantially completed or 

closed out.   
 

Responsibilities:  

 
Schools/Centers 

 
Senior Asset Administrator (SAA) 
The SAA is responsible for obtaining all necessary information required (Description, Location (Building, 

Floor, and Room), Responsible ORG, Custodian, Tagging Contact, etc.) to add any moveable equipment 
acquired and capitalized through construction projects. The SAA is responsible for distributing the tags to 

Tagging Contact and ensuring that all equipment is tagged. The SAA is also responsible for verifying that 
all the School/Centerôs equipment is tagged or identified as untaggable and that tag numbers are 

updated in the assets in BEN Assets after the equipment is tagged.   
 

Asset Administrator (AA)  
The AA is responsible for updating tagging status from ñReady for Taggingò to ñTaggedò or ñUntaggableò, 
and entering the tag number into BEN Assets for any tagged equipment upon notification of tagging 

status and tag number by the Tagging Contact (TC).  The AA may also enter any changes to location, 
Tagging Contact, Custodian, descriptive information, etc. identified by the TC when the asset has been 

verified and tagged. 

 

Tagging Contact (TC) 
The TC is responsible for physically affixing property tags on moveable equipment capitalized through the 

CIP process or, alternatively, for determining that the equipment is not taggable.  The TC is then 
responsible for notifying the AA of the tag number assigned to the asset or that the asset should be 

identified as ñUntaggableò.  The TC is also responsible for verifying, via printed reports, the information in 
BEN Assets (i.e., location, Tagging Contact, Custodian, descriptive information, etc.) is correct with 

regard to the asset at the time of tagging and for notifying the AA of any changes.   

 
Facilities and Real Estate Management (FRES) 

 
The Construction Accounting Group in FRES is responsible for reviewing the construction-in-progress 

(CIP) projects on a monthly basis and notifying PMG that the facility is now occupied. FRES is also 
responsible for assigning the capitalizable costs of non-research related construction to its various 

components and for providing this information to PMG to create the assets in BEN Assets. FRES is also 

responsible for providing documentation to external consultants for componentization of buildings with 
research related activities.  Additionally, FRES is responsible for reviewing equipment expenditures on a 

monthly basis and identifying any assets requiring to be capitalized and informing PMG what costs should 
be capitalized and what costs should be expensed. 

 

Property Management Group (PMG) 
 

PMG is responsible for creating journal entries to close out the project and for adding the building, fixed 

and moveable equipment assets manually to BEN Assets. Upon receipt of information from FRES, PMG 
should coordinate the componentization with external consultants for buildings with research related 

activity. PMG should also capture the grant funding information at the time of entry into BEN Assets.   
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Business Procedure  
 

1. Capital projects include new building construction, or building addition, expansion, enlargement or 
extension and replacement that increase the useful life of an asset. Only those pro jects with a project 

cost over $100,000 will be capitalized. These assets may be created for a substantially completed 

project and/or for a project which has been completed and for which a Final Certification has been 
issued by Office of the Treasurer. 

 
2. Expensing of project costs ï Certain costs incurred during the construction of an asset are not 

capitalizable and should be expensed as incurred.  These costs are recorded as part of the capital 

project in certain 19xx object codes that are then automaticall y closed out to expense at the end of 
each month. 

 
3.  ñClose outò refers to moving costs that have been recorded in construction in progress (19xx object 

codes in the 000010 fund) to either a capitalized asset (1879 Building and Fixed Equipment object 
code or one of the 1870 -1872 moveable equipment object codes) when the asset is substantially 

complete or to expense (5225 Other Non-Capitalized Furniture/Removable Fixtures/Equipment or 

5408 Non-Capital CIP Close-Out) as incurred. 
 

4. Creation of Building and Fixed Equipment Assets 
 

a. On a monthly basis, FRES will review open construction projects and identify which projects 

are substantially complete and should be capitalized.  Projects that are substantially 
complete are those which are ready for occupancy.   

Please note:   Projects may be capitalized even though final payment has not been made 
on the project.   

 

b. FRES notifies PMG that the project is ready to be closed out so that PMG can record the 
project close out in the General Ledger (G\L) and can add the asset in BEN Assets.  

 
i. Non -Research Facilities  - For  projects with non -research related activity ready to 

be capitalized, FRES will review for Payment of Applications and other invoices 
related to the project from contractors and assign the costs of the projec t to the 

various components of the facility or renovation project, such as roof, HVAC, interior 

construction, etc.  FRES will forward this information to PMG along with the 
supporting documents.  

ii. Research Facilities  -  For projects with research related activity ready to be 
capitalized, FRES will provide all supporting documents related to the project to the 

Universityôs external consultant who will then assign the capitalizable project costs to 

the facilityôs various components.   
 

c. Once the Final Certification is prepared and final payment on the project has been made, 
FRES will review invoices that have been received since the project was initially capitalized 

to the time of final payment.  
 

i.  Non -research projects  -  As above, FRES will review non-research projects and 

forward the costs by component to PMG to add to the existing assets in BEN Assets.   
ii. Research projects  - For research projects, FRES will provide the invoices to the 

external consultant who will then componentize the project costs and forward th e 
information to PMG to add to the existing assets in BEN Assets. 



 

é.              Financial Training Department 43  

BEN Assets Business Processes & Procedures  (continued)  

 

Acquisitions ï Capital Projects Closeout  (continued)  
 

5. For all projects, both research and non-research, upon notification that the pr oject is ready to be 
closed: 

 
a. PMG creates a manual journal to close out the construction project as specified in the 

information from FRES to the appropriate clearing account (1879 Building and Fixed 

Equipment object code ). 
 

b. From the component information sent by FRES (non- research related activity) and External 
Consultants (research related activity) PMG creates the assets in BEN Assets. 

 

Please note:  Because the external consultant reviews the research projects on a quarterly 
basis, there will be a delay in some instances between the time the project is closed out 

and added to the clearing account in the G/L and the time the asset is created in BEN 
Assets and the clearing account is cleared in the G/L. 

 
c.  In order to create the asset in BEN Assets, PMG  also needs the following information from 

FRES (Coordinated with SAA in the S/C):  

 Description ï a standard English language description that will be used to identify 

the asset to the School/Center responsible for the asset 
 Installation Location (Building/Floor/Room) - must be a valid location in SPACE  

 Category Code of the asset 

 Responsible Org - the 4-digit ORG that owns or is responsible for safeguarding of 

the asset 

 Does the Govt. Retain Title? Y/N ï if the government does retain title, costs of the 

asset should be expensed 
 Tagging Contact ï the person in the School/Center responsible for tagging the 

equipment and verifying the BEN Assets information related to the asset 

 Tagging Contact Phone number, formatted as follows: ### -### -#### x##, 

including area code and extension, if applicable 

 In-service date ï date asset is placed in service  

 
d. PMG will then create the asset in BEN Assets based on the information provided by FRES 

above.  In addition to the information provided by FRES, PMG must complete the following 
fields in the asset record: 

 Tagged ï PMG will change the Tagged status from ñReady for Taggingò to 

ñUntaggedò for all Building and Fixed Equipment. 
 Tagging Date ï PMG will enter the current date as the Tagging Date after changing 

the Tagged status. 

 Research Amount ï for capital projects funded by grant funds, PMG, in conjunction 

with ORS, will allocate the grant funding among the appropriate building and fixed 

components in accordance with the grant requirements.  
 Capital Program Number ï PMG will enter the G/L capital program number in the 

appropriate field in the Asset Key. 
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e. BEN Assets will create journals to transfer the acquisition cost for assets created from the 
Clearing Account (1879) to the Cost Account (1820).  These entries will be posted to the 

G/L at the end of each month when depreciation is run and the current period in BEN 
Assets is closed. 

 

6. Equipment Purchases as Part of a Capital Project 
 

a. All moveable equipment purchased using CIP object codes for capitalizable equipment 
(19xx)  will be reviewed by FRES to identify those items that qualify as a capitalizable 

asset.  Those equipment costs which do not meet the Universityôs capitalization policy are 
recorded using CIP object codes for expensible equipment (19xx) and are closed-out to an 

expense object code on a monthly basis.  For capitalizable equipment, FRES will provide 

the invoices and property management information (in conjuncti on with the appropriate 
School/Center) to PMG so that PMG can create the asset in BEN Assets.  The property 

management information required to create the asset is as follows:  
 

 Description ï a standard English language description that will be used to ident ify 

the asset to the School/Center responsible for the asset 

 Installation Location (Building/Floor/Room) - must be a valid location in SPACE  

 Category Code of the asset 

 Responsible Org - the 4-digit ORG that owns or is responsible for safeguarding of 

the asset 
 Does the Govt. Retain Title? Y/N ï if the government does retain title, costs of the 

asset should be expensed 

 Custodian - this will also be the primary contact for PMG with any questions 

regarding the asset 
 Custodian Phone number, formatted as follows: ### -### -#### x##, including 

area code and extension, if applicable 

 Tagging Contact ï the person in the School/Center responsible for tagging the 

equipment and verifying the BEN Assets information related to the asset 
 Tagging Contact Phone number, formatted as follows: ### -### -#### x##, 

including area code and extension, if applicable 

 In-service date ï date asset is placed in service  

 

If the item does not qualify as a capitalizable asset, FRES will then notify PMG of cost to 
be expensed. PMG will prepare an entry to expense the cost.  

 
b. Upon notification by FRES, PMG creates a manual journal to close out the equipment 

purchased as part of the construction project to the appropriate object code: 
 

1870  Furniture and Fixtures  

1871  Computer Equipment  
1872  Other Capitalized Equipment  

 
c. PMG will then create the equipment asset in BEN Assets based on the information provided 

by FRES above. 

 
d. BEN Assets will create journals to transfer the acquisition cost for assets created from the 

Clearing Account (187x) to the Cost Account (1821).  These entries will be posted to the 
G/L at the end of each month when depreciation is run and the current period in BEN 

Assets is closed. 
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Acquisitions -  Manual Journal Entries  to  Clearing Accounts, Returns, Cash 
Refunds  

 

Overview  
 

This procedure describes the process for review of manual journal entries and BEN Deposit entries made 
into the clearing accounts in the General Ledger and creation or adjustment of assets resulting fro m 

these journals.   
 

Responsibilities:  

 
Schools/Centers 
 

Business Administrator (BA) 
The BA who creates the journal is responsible for informing PMG when the journal is created and for 
providing PMG with the information necessary to create the asset, including descriptions, location 

(building, floor and room), responsible ORG, category code, Tagging Contact, Custodian, in-service date, 

PO and invoice information, etc.  If the entry adjusts the cost of an existing asset, the BA should provide 
the number of t he asset to be adjusted as well as the PO and invoice information. 
 

Property Management Group 
 

The Property Management Group (PMG) is responsible for reviewing the clearing accounts on an on-

going basis for any manual journal entries or BEN Deposits journal entries to determine whether an asset 
needs to be created or adjusted and for creating or adjusting the asset in BEN Assets.  
 

Business Procedure  
 

Manual Journal Entries ï Assets Originally Recorded as Expense  
 

1. On occasion the School/Centers may create a manual journal to transfer costs from an expense 
object code to the asset object code.  This will occur in instances when an asset which should have 

been capitalized was booked as an expense, and the entry is made by the School/Center to correct 
this error by crediting the expense account and debiting the asset clearing account (object codes 

1870, 1871, 1872, 1874 or 1877).  

2. When the School/Center creates this entry, it should also forward to PMG the information needed to 
create the asset in BEN Assets, including: 

 PO # 

 Supplier Name 

 Supplier Number 

 Invoice #  

 Clearing account debited in journal entry (xxx -xxxx-x-xxxxxx-187x-xxxx-xxxx) 

 Description 

 Location ï Building, Floor and Room 

 Category Code 

 Responsible ORG 

 Tagging Contact 

 Tagging Contact Phone Number 

 Custodian 

 Custodian Phone Number 

 Date asset was placed in service 

 Component, Y/N 

 Primary asset number, if the asset is a component of an existing asset 

 Batch name of correcting journal  
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The School/Center may provide this information using the ñEquipment Information Formò available on 
the Comptrollerôs web site.  http:/ /www.finance.upenn.edu/comptroller/forms/index.shtml#PropMan  

 
3. Using the information provided by the School/Center, PMG will create the asset in BEN Assets. 

 

4. PMG will also periodically, but at least once a month, review the activity in the clearing account s for 
manual entries.  For any manual journals created for which PMG has not received the information 

necessary to create the asset in BEN Assets, PMG will contact the creator of the journal to obtain this 
information.  

 

5. BEN Assets will create journals to transfer the acquisition cost for assets created from the Clearing 
Account (187x) to the Cost Account (1821).  These entries will be posted to the G/L at the end of 

each month when depreciation is run and the current period in BEN Assets is closed. 
 

6. If upon  review of the manual journal, PMG determines that a new asset should not be created or an 
existing asset adjusted, PMG will notify the School/Center that the transaction does not qualify as a 

capital asset and the School/Center will reverse or otherwise correct the entry to the clearing 

account. 
 

Manual Journal Entries ï Cost Adjustments following the Return of an Asset  
 

1. On occasion the School/Centers may return assets for either credit  or a refund .  See below for 

additional information specifically regarding a ócreditô or órefundô.   
 

Please note:  In instances where an asset is returned and the credit or refund is less than the 
acquisition cost of the asset , the School/Center must prepare a manual journal entry to charge 
(debit) expense (5224 Non-Capitalized Computer Equipment & Peripherals or 5225 Other Non-
Capitalized Furniture/Removable Fixtures/Equipment) and reduce (credit) the asset clearing account 
(1870,1871, 1872, 1874  or 1877) for the difference between the acquisition cost of the asset and 
the amount of the refund or credit.  

 

2. The School/Center should also notify PMG in writing of the return and the asset or assets to which 
the cost adjustment applies so that PMG can apply the credit against the proper asset(s) in BEN 

Assets. 

 
3. Upon recording of the cost adjustment to the asset clearing account and upon notification by the 

School/Center of the cost adjustment, PMG will adjust the asset cost in BEN Assets.  PMG will also 
maintain documentation of the cost adjustment, including authorization by the S chool/Center for the 

cost adjustment. 

 

4. BEN Assets will create journals to transfer the credit for any asset whose cost is adjusted from the 

Clearing Account (187x) to the Cost Account (1821), reducing the asset cost.  These entries will be 

posted to the G/ L at the end of each month when depreciation is run and the current period in BEN 
Assets is closed. 

 
5. PMG will also periodically, but at least once a month, review the activity in the clearing accounts for 

manual credit entries.  For any manual journals created for which PMG has not received the 

information necessary to adjust the cost of the asset in BEN Assets, PMG will contact the creator of 
the journal to obtain this information.  

http://www.finance.upenn.edu/comptroller/forms/index.shtml#PropMan
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Returns of Assets for Credit  

 
1. When an asset is returned to the vendor, a credit memo may be issued by the vendor.  This credit is 

processed by Accounts Payable (A/P) and applied to the asset clearing account (1870, 1871, 1872, 

1874 or 1877) which incurred the original charge.   
 

2. Once the credit from the vendor has been processed by A/P, the credit will be posted to the G/L by 
A/P.  For any transactions posted by A/P to the asset clearing accounts (object codes 187x), A/P will 

also transfer the P.O. and invoice information, including the information from the property form in 

the original requisition, to BEN Assets.  Once this information transfer is made, the equipment 
acquisition information is available to be viewed by PMG in BEN Assets in the Mass Additions 

Workbench. 
 

3. On a daily basis PMG will review the items in the Mass Additions Workbench of BEN Assets. PMG will 
review the ñFA ï Purchase Orders Existing in BEN Assetsò Business Objects standard query to identify 

credits that need to be applied to existing assets.  PMG will review of the purchase order/invoice to 

determine if the credit needs to be merged with another invoice/credit; to determine if the credit 
needs to be split among multiple assets; and/or to determi ne if the credit was related to costs that 

did not qualify for capitalization. PMG will then add these credits to existing assets using the ñAdd to 
Assetò button, as appropriate.  See PP&E Procedure ñAcquisitions:  Assets Purchased via BEN Buysò 

for more details. 

 
4. BEN Assets will create journals to transfer the credit for any asset whose cost is adjusted from the 

Clearing Account (187x) to the Cost Account (1821), reducing the asset cost.  These entries will be 
posted to the G/L at the end of each month whe n depreciation is run and the current period in BEN 

Assets is closed. 

 
5. On occasion, the amount of the refund may be less than the acquisition cost of the asset.  In these 

instances, the School/Center that owned the asset should prepare a manual journal entry to charge 
(debit) expense (5224 Non-Capitalized Computer Equipment & Peripherals or 5225 Other Non-

Capitalized Furniture/Removable Fixtures/Equipment) and reduce (credit) the asset clearing account 
(1871 Moveable Equipment) for the difference between th e acquisition cost of the asset and the 

amount of the refund.  PMG will then make an additional cost adjustment to reduce the acquisition 

cost of the asset to zero since the University no longer owns the asset.  PMG will also maintain 
documentation of the cost adjustment, including authorization for the cost adjustment.  See section 

ñManual Journal Entries ï Cost Adjustments following Returnsò for more details.  
 

Returns of Assets for Cash Refunds  

 
1. When an asset is returned to the vendor in exchange for a cash refund, the refund should be 

deposited via BEN Deposits to the asset clearing account (1870, 1871, 872, 1874 or 1877) which 
incurred the original charge.  The BEN Assets number(s) of the asset(s) returned should be included 

in the description of the d eposit. The BEN Deposits feeder will post the deposit to the asset clearing 
account on a daily basis.    

 

2. Upon deposit of the refund to the asset clearing account and upon notification by the School/Center 
of the refund, PMG will adjust the asset cost in BEN Assets.  PMG will also maintain documentation of 

the cost adjustment, including authorization by the School/Center for the cost adjustment.  
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3. BEN Assets will create journals to transfer the credit (deposit) for any asset whose cost is adjusted 

from the Clearing Account (187x) to the Cost Account (1821), reducing the asset cost.  These entries 
will be posted to the G/L at the end of each month w hen depreciation is run and the current period in 

BEN Assets is closed. 
 

4. On occasion, the refund may be less than the acquisition cost of the asset.  In these instances, the 

School/Center that owned the asset should prepare a manual journal entry to charge  (debit) expense 
(5224 Non-Capitalized Computer Equipment & Peripherals or 5225 Other Non-Capitalized 

Furniture/Removable Fixtures/Equipment) and reduce (credit) the asset clearing account (1871 
Moveable Equipment) for the difference between the acquisition cost of the asset and the amount of 

the refund.  PMG will then make an additional cost adjustment to reduce the acquisition cost of the 
asset to zero since the University no longer owns the asset.  PMG will also maintain documentation of 

the cost adjustment, including authorization for the cost adjustment.  See section ñManual Journal 

Entries ï Cost Adjustments following Returnsò for more details.  
 

5. PMG will also periodically, but at least once a month, review the activity in the clearing accounts for 

cash deposit entries.  For any BEN Deposits entries created for which PMG has not received the 
information necessary to adjust the asset in BEN Assets, PMG will contact the creator of the deposit 

to obtain this information.  
 

Returns of New Equipment for Repla cement Equipment  

 
1. When a new asset is returned to the vendor in exchange for a replacement asset (for example, if it is 

damaged upon receipt), the School/Center must tag the replacement asset, if the equipment is 
taggable, and update the tag number and the  tagging date for the tag affixed to the replacement 

asset.  The School/Center must also update the descriptive information in BEN Assets (serial number, 

model number, etc.), as appropriate.  
 

Trade - in of Existing Equipment  
 

1. When an existing piece of equipment is being traded-in as part of the acquisition of a new piece of 
equipment, the disposal of the item being traded -in should be approved in accordance with Policy 

#1106.3 Plant Assets: Disposals using the ñAuthorization for Disposal of Equipmentò form.  Once the 

asset has been traded-in, the Asset Administrator should retire the asset in BEN Assets.  See also 
PP&E Procedures: Retirements for more details  
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BEN Assets Business Processes & Procedures  (continued)  

 

BEN Assets ï Verification & Tagging  
 

Overvi ew  
 

This procedure describes the process for verifying  and tagging  capitalized movable equipment acquired 

by the University.  Verification and tagging of equipment should be done within 30 days after it is added 
to BEN Assets. 

 
Responsibilities:  

 

Schools/Centers 
 

Senior Asset Administrator (SAA) 
The SAA is responsible for ensuring that the Asset Administrators, Tagging Contacts and Custodians 

perform their duties, as appropriate, in the process of verifying and tagging equipment.  The SAA or 
his/her designee is also responsible for the distribution of tags to the Tagging Contact(s) within his/her 

School/Center and for requesting additional tags from PMG when needed.   

 
Asset Administrator (AA) 
Upon notification of tagging status and tag number by the Tagging  Contact (TC), the AA is responsible 
for updating the tagging status from ñReady for Taggingò to either ñTaggedò or ñUntaggableò and 

entering the actual tag number and Tagging Date into BEN Assets for any tagged equipment.  The AA 

may also update any changes to location, Tagging Contact, Custodian, descriptive information, etc. 
identified by the TC when the asset has been verified, via printed reports, and tagged.  

 
Tagging Contact (TC) 
The TC is responsible for physically affixing tags on moveable equipment under his/her purview or, 
alternatively, for determining that the equipment is not taggable.  The TC is then responsible for notifying 

the AA of the tag number assigned to the asset or that the asset should be identified as ñUntaggableò.  

The TC is also responsible for verifying, via printed reports, the information in BEN Assets (i.e., location, 
Tagging Contact, Custodian, descriptive information, etc.) is correct with regard to the asset at the time 

of tagging and for notifying the AA of any changes requ ired in BEN Assets.   
 

Please note:  In instances where the TC is also the AA, he/she should make any updates or 

changes directly to BEN Assets.   
 

Custodian 
The Custodian will assist the Tagging Contact in locating the asset(s) to be tagged.  In some inst ances 

the Custodian may also be the Tagging Contact.     
 

Property Management Group (PMG) 

 
PMG has oversight responsibility for ensuring that policies and procedures relating to the verification and 

tagging of assets are followed by the Schools/Centers.  It will also include developing metrics by 
School/Center and tracking the status of assets that require tagging.  

 

PMG is responsible for providing an initial supply of tags to each School/Center.  The quantity of tags to 
be sent out will vary depending on t he volume of equipment purchases within each School/Center.  When 

the supply of tags runs low, the SAA is responsible for contacting the PMG for an additional supply of 
tags. 
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BEN Assets Business Processes & Procedures  (continued)  

 

BEN Assets -  Verificat ion & Tagging  (continued)  
 

Definitions  
 

1. Capitalized equipment refers to an item of non-expendable tangible personal property with a useful 
life of more than one year, a cost in excess of $5,000 per item, excluding freight charges and taxes, 

and for which t he University has title.  In addition, acquisitions of individual items of software with an 

acquisition cost of $5,000 or more will be considered a capital asset.  
 

2. ñMoveable equipmentò refers to equipment which can be easily moved from one area to another.  
 

 

Business Procedure  
 

1. PMG will send an initial supply of tags to the Senior BA of each School/Center, who will forward the 
tags to the designated SAA(s).  This initial supply will be based on the volume of purchases of the 

School/Center.  When the supply runs low, the SAA will request from PMG a replacement supply of 
tags.  The SAA will distribute tags to the TC as required. 

 

2. Periodically, but at a minimum of once a month, the SAA or AA will run a report in BEN Reports which 
will show assets which are ñReady for Taggingò.  This report will show the new additions which need 

to be verified and tagged.  This report will be given to the TC to use for tagging and verifying the 
assets.  The TC should obtain tags from the SAA or their designee. 

 

3. The TC will perform the following activities:  
a. Once the TC has received the report of equipment to be tagged, the TC should tag 

equipment within 30 days.  
 

b. Once the TC has physically located the equipment, he/she should determine the following:  

1) Does the equipment item listed on the report represent a single item?  
2) Does the equipment item listed on the report represent multiple items which need to be 

split into multiple assets in BEN Assets? 
3) Does the equipment item listed on the report represent a component of another asset 

already in BEN Assets? 
 

If the answer to #2 or # 3 is óYesô, the TC must notify the PMG so that they can correct 

the equipment item information in BEN Assets.  Tagging should not occur until the 
asset has been updated.    

 
Please note:  The TC may notify the AA of the need for correction instead of the PMG 

directly.  The AA must then notify the PMG immediately.   

 
c. If the equipment is a single asset that does not require adjustment, the TC must determine 

whether the equipment is ñTaggableò or ñUntaggableò.  If the equipment cannot be 
tagged, the TC must make a notation on the report, next to the asset, that the equipment is 

ñUntaggable.ò  ñUntaggableò equipment includes but is not limited to software and additional 
computer components placed inside computer cases.   
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BEN Assets Business Processes & Procedures  (continued)  

 

BEN Assets -  Verification & Tagging  (continued)  
 

d. If the equipment is ñTaggable,ò the TC will physically affix the tag on the equipment so it is 
visible and can be scanned during inventory.  The TC must then notate on the report the tag 

number assigned to the equipment.   
Tags must be placed on equipment so that they are readily visible.  Suggested locations for 

tags include: 

 Computer equipment ï on the front or back  

 Vehicles ï next to VIN number  

 Microscopes ï on the base 

 Camera ï on the back 

 Refrigerators/freezers ï on the front door or top (if chest freezer)  

 Other ï in a location where the tag is visible and can be scanned  

 
e. Additionally, the TC must then verify or provide the information require d in BEN Assets as 

listed on the report and notate any changes that need to be made to the system on this 
report.   
 

The following fields must be verified by the TC:  
 

 Tag Number (if the item has been tagged)  

 Tagging Status (Tagged, Untaggable, or Untaggable Remote) 

 Tagging Date (for Tagged items, this is the date the tag was affixed to the item; 

for Untaggable items, this is the date the asset was determined to be 

untaggable) 

 Location (Building/Floor/Room) 

 Category Code 

 Responsible ORG  

 Custodian Name 

 Custodian Telephone 

 Tagging Contact Name 

 Tagging Contact Telephone 

 
It is recommended but not required  the following fields also be updated: 
 

 Description 

 Model Number 

 Serial Number 
 

f. Once the asset information has been verified by the TC and, where necessary, the asset has 
been tagged, the TC forwards to the AA the changes/adjustments that need to be made to 

the asset in BEN Assets.  
 

4. Once the TC has given the AA the report with the notated changes, the AA should update the assets 
in BEN Assets.  Go to the sectio n titled óBEN Assets ï Updates and Maintenance ô to see how 

to perform this activity  in BEN Assets . Any changes in Category Code required, however, must 

be forwarded to PMG in writing so that PMG can update the system. 
 

5. The BEN Assets system validates the tag number when it is entered to ensure that the tag is not 
already assigned to an existing asset.  The BEN Assets system will also validate any changes to 

Custodian and Tagging Contact to ensure they are valid employees and will validate changes to 
location to ensure it is a valid location in Facilitiesô SPACE system.  Any incorrect or invalid 

information should be replaced with the correct, valid data.  
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BEN Assets Business Processes & Procedures  (continued)  

 

BEN Assets -  Verification & Tagging  (continued)  

 
6. Departments can opt to tag equipment upon receipt, prior to the addition of the asset to BEN Assets.  

This may be necessary when the equipment received is to be installed and the invoice has not yet 

been received or processed. If the equipment is to be pr oactively tagged, the TC should make a note 

of the tag number assigned to the equipment and should also make a note of the information 
required to be verified so that this can be verified against what is in BEN Assets when the asset is 

added to the system.     
 

7. Metric Reporting 

 

a.  The SAA should periodically, but at a minimum of once a month, run the ñAging Report of 
Untagged Equipmentò for Responsible ORGs within his/her School/Center to identify assets 

that have a tagging status of ñReady for Taggingò.  All moveable assets should be tagged 
within 30 days of being entered into BEN Assets.  Any equipment items that remain untagged 

beyond this timeframe should be investigated by the AA.  
 

b.  On a monthly basis, PMG will run the ñAging Report of Untagged Equipmentò for all 
Responsible ORGs.  The PMG will then maintain metrics on the number of items that remain 

untagged for more than 30, 60, 90, 120 days, etc. for each School/Center.  The PMG will 
follow up with the Senior BA of Schools/Centers with significant numbers of untagged items. 
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BEN Assets -  Inquiry  

Inquiry>Financial Information  

  
To view asset information, such as óFinancial Informationô or óTransaction Historyô there are a variety of 

ways to perform a search.  The following pages will show how to perform an inquiry as well as the 

information retrieved upon performing such an inquiry.   

 

 From the Senior Asset 

Administrator  or the Asset  

Administrator  responsibility, 

click on Inquiry>Financial 

Information from either the 

BEN Financials Homepage or the 

Navigator  
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BEN Assets ï Inquiry (continued)  
 

Inquiry>Financial Information (continued)  
 

o Find by Asset Detail  

o Enter search criteria such as Asset Number, Tag #, Description, Category, etc. 

o Click on [Find]  

 
 

 

 Employee Name 
and Number fields 

not used at Penn  

Not man y  

Leases at Penn  
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BEN Assets ï Inquiry (continued )  

Inq uiry>Financial Information (continued)  

The results after clicking on [ Find ]  appear below:   

 
 

 

 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

F In order to query on any of the fields in the óAsset Categoryô descriptive flexfield, please 
see the section titled óQuerying from the Asse t Category Descriptive Flexfieldô 

 
 

 
 

Phone number not 

listed in original 
Property 

Management 

System  
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BEN Assets ï Inquiry (continued )  
 

Inquiry>Financial Information (continued)  
 
Using the scrollbar at the bottom, scroll to the right to see all the inquiry fields available for the asset.  

 

 
 
 

 
 

Asset Type:  Either 

Capitalized  or CIP  - 
which means EIP  for 

Penn assets 

A Capital Program Number  is 

assigned to a capital project which 
includes new building construction, or 

building addition, expansion, 

enlargement or extension and 
replacement that increase the useful 

life of an asset. 
 

 

The Legacy Asset Number is the 

number that was assigned to the 
asset in the Property Management 

System ï the system used to manage 

assets before BEN Assets was 
implemented.  

 
 

To access the Asset 

Key  field, from  the 
menu, click on 

Edit>Edit Field  

Property Type  and 
Property Class  fields 

are not used at Penn 
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BEN Assets ï I nquiry (continued)  
 

Inquiry>Financial Information (continued)  
  
[Assignments]  (i.e. Location) 
 

o To view the location of the asset, click on [Assignments]  
 

o From the óLocationô field, click on Edit>Edit Field  to view the Building, Floor and Room  

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 

[Source Lines]  
 
o To view the source lines for an asset, click on [Source Lines]  

Can see the PO # -  
this is complete  if 

needed to search 
for invoi ce.  

Account where d epreciation is 

charge d a monthly basis ï at 
University level on ly . 

Invoice # -  Note if this 
is a PMS asset , Invoice 

# may not be a partial 
# ï use wildcards (%) 

to assist in search of 
actual invoice in 

Inquiry>Invoice  
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BEN Assets ï Inquiry (continued )  
 

Inquiry>Financial Information (continued)  
 

[Books]  
 

o To view financial information such as the original cost, useful life and a ccumulated depreciation, etc, 

click on [Books]  
 

 

[Books]>[Transactions]  
 

o To view the ótransactions relating to an asset, click on [Transactions]  
 

Every asset wi ll 

have  two lines 

when the asset is 
first added in  

BEN Assets  
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BEN Assets ï Inquiry (continued)  

Inquiry >Transaction History  

 

 
 From the Senior Asset 

Administrator  or the Asset  

Administrator  responsibility, 

click on Inquiry>Financial 

Information from either the 

BEN Financials Homepage or 

the Navigator 

o In the Book field, type 

UNIVERSITY BOOK  

F This is the only option in 
this field 

 
o In the Asset Numbers field, 

enter the asset number(s)  

desired 

o Click on [Find]  

 
 
 

No need to enter 
Reference Number  
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BEN Assets ï Inquiry (continued)  
 

Inquiry > Transaction History  (continued)  
 
o The form below appears.  Click on [Details]  for each line to see more information.  

 

 

The óTransaction 
Typeô will 

determine the 

óDetailsô to be 
displayed  
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BEN Assets ï Inquiry (continued)  

 

Inquiry>T ransaction History (continued)  
 
Transaction Type Table   
 

Transaction Type  Description  

ADDITION 

This transaction type is used to indicate the financial information related to 
the asset was created or updated in the period the asset is created, 

including the creation of the asset, or changes to the acquisition cost of the 

asset, depreciation method, or useful life.  

ADDITION/VOID 

An ñADDITIONò transaction type becomes ñADDITION/VOIDò to indicate 

that the financial information has been updated in the same mon th in which 
the asset was created and that the financial information on this line is no 

longer current.  Changes to financial information after the month of creation 
are shown as ñADJUSTMENTò 

ADJUSTMENT 
A change to financial information made after the mon th in which the asset 
was originally created. 

FULL RETIREMENT This transaction type is used when an asset has been fully retired. 

RECLASS A change in the Category of the Asset. 

REINSTATEMENT 
This transaction type indicates that an asset that had been re tired has been 

reinstated. 

TRANSFER IN 
This transaction type is used upon the initial assignment of an asset to a 

location. 

TRANSFER 
This transaction type is used for and changes to assignment/location 

information.  
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BEN Assets ï Updates and Maintenance  

Assets>Asset Workbench  

 
In order to perform updates on an asset, such as entering the Tag # or ómaintenanceô such as changing a 

Custodian or Tagging Contact or change an óassignmentô i.e. location of an asset in BEN Assets, users 

need to perform these functions from the óAsset Workbenchô.   

 

 From the Senior Asset Administrator  or 

the Asset  Administrator  responsibility, 

click on Assets>Asset Workbench from 

either the BEN Financials Homepage or the 

Navigator 

 
o Enter any of the same search criteria 

described in the Inquiry section  

o Click on [Find]  
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BEN Assets ï Updates & Maintenance  (continued)  
 

Assets > Asset Workbench  (continued)  
 

When the Assets form in Asset Workbench appears, edits are not able to be performed yet.  We must 

either click on [Assignments ]  to change the location or [Open]  to adjust/edit/add all other fields 

available to be updated. 

 

This is not where 

óupdatesô are 
performed.  Need to 

click on [Open] to 
update an asset.  See 

later in User Guide  

[Financial Inquiry] is 
the same as [Book s] 

described previously in 
Inquiry>Financial 

Information  
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BEN Assets ï Updates & Maintenance  (continued)  
 

Assets > Asset Workbench  (continued)  
 
[Assignments] a.k.a. Rel ocation  of an Asset  
 
Overview  

 
This procedure describes steps necessary to be taken to ensure that the relocation of equipment is 

properly authorized and accurate records are maintained. 
 

Responsibilities:  

 
Schools/Centers 

 
Senior Asset Administrator (SAA) - The SAA is responsible for ensuring that the School/Center is properly 

updating BEN Assets for relocations of assets and for maintaining proper documentation supporting such 
relocations. 

 
Asset Administrator ï The Asset Administrator (AA) is responsible for updating BEN Assets for changes in 
locations as well as for completing/maintaining the ñHome Use/Remote Locationò and ñEquipment 

Changeò forms.  The AA is also responsible for generating the Relocation Report in order to verify that 
the location change was properly recorded in BEN Assets. 

 

Tagging Contact (TC) ï The TC is responsible for notifying the AA in writing of the location or 
Responsible ORG change. 

 
Custodian - The Custodian is responsible for notifying the AA in writing of the location or Responsible 

ORG change for equipment for which he/she is responsible.  The Custodian is also responsible for 

completing the ñHome Use/Remote Locationò form for any equipment he/she will use at home, for 
obtaining the necessary approvals and for forwarding the approved form to the AA to update BEN Assets. 

 
Department Chair, Director or Senior Business Administrator (Senior BA) ï the Department Chair, Director 

or Senior BA is responsible for approving the removal of any equipment from on-campus to an off-
campus location. 

 

Business Procedure  
 

1. Relocation of Equipment 
 

The School/Centers may on occasion move equipment from one location to another and/or between 

Responsible ORGs within their School/Center, in accordance with their business needs. 
 

a. When these relocations and/or transfers occur, the appropriate TC or Custodian is 
responsible for notifying the AA of the location change and/or the Responsible ORG change 

so the AA may update this information in BEN Assets.  The TC or Custodian will also notify 
the AA of any corresponding changes in Custodian or Tagging Contact related to the 

relocation, as well as the respective phone number changes.  This notification should be 

made in writing , via e-mail or in memorandum format, to document the change(s) 
requested. 



 

é.              Financial Training Department 65  

BEN Assets ï Updates & Maintenance  (continued)  
 

Assets > Asset Workbench  (continued)  
 

[Assignments] a.k.a. Relocation of an Asset  (continued)  
 

b. Upon notification of the change, the AA will update the relevant information in BEN Assets 

and notify the requestor that the change has been made.  The TC or Custodian requesting 
the change should review the Report of Location Changes to verify that the change has been 

made correctly. 
 

2. Home Use or Remote Location  
 

On occasion, an employee may be required to use University-owned equipment at home or at a 
remote, off -campus location, such as overseas.  In these instances, removal of the asset from the 

University must be authorized.  
 

a. The requesting Custodian must complete the ñHome Use/Remote Locationò form and obtain 

the approval of the Department Chair, Director or Sen ior BA. 
 

b. Once the form has been approved, the Custodian should maintain a copy for his/her records 
and should forward the original to the AA.  The equipment may now be physically removed 

from the University premises by the Custodian.  
 

c. The AA updates BEN Assets with new location:  

i. For Home Use equipment, the location is 7012 -N/A -N/A  
ii. For Remote Location equipment, the location is 7023 -N/A -N/A  

 

d. The AA also updates any other necessary information, including changes to Custodian, 

Custodian Phone Number, Tagging Contact, Tagging Contact Phone Number, and 
Responsible ORG 

 

e. The AA should maintain the original form until the item is returned or disposed, in 

accordance with the Universityôs record retention policy.  
 

f. When the equipment is returned to the University, th e Department Chair, Director or Senior 

BA should complete and sign the return section of the ñHome Use/Remote Locationò form to 
acknowledge return of the equipment.  A copy of the signed form should be provided to the 

employee returning the equipment for h is/her records.  The form should then be forwarded 
to the AA to update the location in BEN Assets for the on-campus location of the asset as 

well as any changes required to the Custodian and TC. 
 

Please note:  In instances where the equipment is originally  shipped to the remote 

location, the shipping address, as well as the remote location entered in the property 
information form of the requisition, authorized in the purchase order, serves as 

authorization of the remote location and a ñHome Use/Remote Locationò form does not 
need to be completed.  The remote location will be entered by the PMG upon creation of 

the asset in BEN Assets. 

 
3. Transfer Between Schools/Centers 

 
a. The AA from the sending School/Center should complete the Equipment Change form and 

have it approved by the Senior BA of his/her School/Center. 
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BEN Assets ï Updates & Maintenance  (continued)  
 

Assets > Asset Workbench  (continued)  
 

[Assignments] a.k.a. Relocation of an Asset  (continued)  
 

 

b. The AA should then have the form approved by the Senior BA of the receiving School/Center 
who must also complete the new location and Responsible ORG information. 

 
c. Once the form is completed and all approvals have been obtained, the equipment is then 

physically moved to the new location.  
 

d. The AA of the sending School/Center will review the form and update BEN Assets with the 

new location, Custodian, Tagging Contact and the Responsible ORG, as appropriate.   
 

e. If the receiving School/Center is ñpurchasingò the equipment from the sending 
School/Center, the sending School/Center should record a funding transfer in the G/L using 

object code 4826  Equipment Close -out  to debit (charge) the receiving School/Center and 

credit the sending School/Center.  The journal batch name to record the transfer should be 
notated on the Equipment Change Form. 

 
f. A copy of the completed Equipment Change Form should be forwarded to the receiving 

School/Center.  Copies of the form should be maintained by the School/Center in accordance 
with the Universityôs record retention policy. 

 

g. The AAs of both Schools/Centers should review the Report of ORG Changes to verify that the 
change(s) has been made correctly. 

 
4. Reports 

 

a. Periodically, but at least once a month, the AA will run the ñAsset Change Historyò standard 
query in Business Objects to determine that all location changes within his/her School/Center 

are authorized and that all authorized location changes were properly made.  
 

b. Periodically, but at least once a month, the AA will run the ñAsset Change Historyò standard 

query in Business Objects to determine that all location changes within his/her School/Center 
or between his/her School/Center and another School/Center are authorized and that the 

authorized ORG changes were properly made. 
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BEN Assets ï Updates & Maintenance  (continued)  
 

Assets > Asset Workbench  (continued)  
 
 [Assignments] a.k.a. Relocation of an Asset  (continued)  

 

o In order begin the process of changing a location  in BEN Assets , i.e. Building, Floor and or Room, 

click on [Assignments]  

o In the Unit Change  field, enter a -1  to remove the unit from itôs current location 

F The number of óUnitsô should always be ó1ô as each asset is counted as 1 unit in BEN Assets 

 

o Arrow down  or press [Tab]  to add a new line 

o On the new line, in the Unit Change  field, enter a ó1ô 

o The Units & Expense Account fields will default  

o Tab to the Location  field 

F This field is validated with the óLocationsô in Space@Penn 
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BEN Assets ï Updates & Maintenance  (continued)  
 

Assets > Asset Workbench  (continued)  
 
[Assignments] a.k.a. Relocation of an Asset  (continued)  
 
o Click on LOV and type either a Building number or search by typing a portion of the Building name 

e.g. type %frank% to search for óFranklin Buildingô  

 

 
o Click on [Find]  

 

 
 

 
 

 
 

 

 

 
o Click [OK]  on the  

building desired, in this 
case the Franklin Bldg 

 
 

 

 
 

o Click on [Combinations ]  
 

 

 
 

 
 

 
 

 

o Click on [OK]  immediately to see all the Building, Floor and Room 
combinations for the building you selected  

 

 



 

é.              Financial Training Department 69  

BEN Assets ï Updates & Maintenance  (continued)  
 

Assets > Asset Workbench  (continued)  
 
[Assignments] a.k.a. Relocation  of an Asset  (continued)  
 

o Scroll down to the Building, Floor and Room combination 

desired 

o Click [OK]   

  

  

  

  

  

  

  

  

  

 

o The Location is now populated 

o Click on [Done]   

 

 

 

 

 

Reminder:  The Location  field is validated 
with the óLocationsô in Space@Penn i.e. if 

you type each field separately and it 

doesnôt match the Space@Penn database 
you will see a message at the bottom of 

your screen that reads óPlease choose an 
existing combination.ô 
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BEN Assets ï Updates & Maintenance  (continued)  

Assets > Asset Workbench  (continue d)  

[ Open ]  
 

o In order begin the process of updating (Tag #, Serial #, etc.) or changing a variety of fields, such as 

Custodian, Tagging Contact etc, click on [ Open ]  

 

 
  

 

 
 

 
  

  

   
 
 

 
o The following fields are updatable by the user:  

 
Asset Details:   Asset Category:  
 
Tag Number Custodian Name/Phone Number  
Serial Number Tagging Contact Name/Phone Number 
Manufacturer Responsible ORG 
Description Taggable 
Model Tagging Date 
 Located During Inventory 
  

Any changes made 

to the Research 
Amount, Last  Date 

of Inventory, 
Component Y/N or 

Primary Asset 

Number  fields will 
not be saved 
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BEN Assets ï Updates & Maintenance  (continued)  

Assets > Asset Workbench  (continued)  

Querying from the Asset Category Descriptive Flexfield  (DFF)  
 
In order to begin the query in the Asset Workbench  
 

o Close the Find Assets  
window by clicking on the X 

in the upper right hand 

corner 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
o The Assets  form wi ll appear   

 
 

o From the menu at the top, click on Tools>Enter Query   
 

 

 
 

 
 

 

o The Assets  form will now be in query mode  
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BEN Assets ï Updates & Maintenance  (continued)  

Assets > Asset Workbench  (continued)  

Querying from the Asset Category Descriptive Flexfiel d (DFF)  
 
o Click in the Descriptive Flexfield (beer mug) 

 

  
  

  

  
  

  

 
o Enter the search criteria in any desired field, e.g. Custodian 

 
F For Custodian and Tagging Contact fields, select names from a list of values (LOV) 

 
o Click on [OK]  

 

 

 
 

 
 

 

 
 

 
 

 

 
 

 
o The search criteria is entered so we can now execute the search 

 
o From the menu, click on View>Query by Example>Run  or press [Ctrl] F11  
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BEN Assets ï Retirements  
 

Overview  

 
This procedure describes the procedures Schools and Centers must follow to properly retire assets that 

have been sold, transferred, discarded or otherwise disposed of. 
 

Responsibilities:  

 
Schools/Centers 

 
Senior Asset Administrator (SAA) ï The SAA is responsible for recording the retirement of moveable 

equipment and collectibles, including donated equipment and collectibles, belonging to his/her center.  

Such assets include any items assigned to a Responsible ORG that is designated as belonging to the 
Center.  Prior to recording the retirement of the asset in BEN Assets, the SAA is responsible for ensuring 

all authorizations have been received, that grant requirements identified by ORS have been met and that 
the asset has been physically disposed.  

 

Asset Administrator (AA) ï The Asset Administrator is responsible for completing the ñAuthorization for 
Retirement of Equipmentò form and obtaining the appropriate authorizations prior to disposition of the 

asset.  The AA should also notify the Tagging Contact or Custodian of any grant requirements. 
 
Tagging Contact (TC)/Custodian ï The TC and Custodian are responsible for identifying moveable 
equipment and collectibles to be retired and for initiating the retirement process by notifying the AA of 

the impending retirement of the asset.  This includes retirement due to theft or casualty loss.  The TC or  

Custodian that initiates the retirement is also responsible for ensuring that grant requirements are met 
upon the disposal of the asset.   

 
In instances where the retirement of the asset is due to theft, the TC or Custodian who identifies the loss 

must promptly report the theft both to the Office of Public Safety and to the Office of Risk Management. 

If the retirement is due to casualty loss, the TC or Custodian who identifies the loss must notify the Office 
of Risk Management of the loss. 

 
Property Management Group (PMG) 

 

The Property Management Group is responsible for recording the retirement of land, buildings, fixed 
equipment, and library books belonging to the University.  

 
Facilities and Real Estate Services (FRES) 

 
Facilities is responsible for obtaining proper authorization for the retirement of any land or buildings 

owned by the University and for notifying PMG of the retirement of such asset upon disposition.  

 
Office of Research Services (ORS) 

 
Research Services is responsible for reviewing the grant requirements for any moveable equipment 

purchased with grant funds and notifying the retiring school/center of these requirements.  
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Business Procedure  

 

1. Initiation of Retirement Process 
 

The Tagging Contact or Custodian during the normal course of their business may identify moveable 
equipment that needs to be retired due to the assetôs replacement, loss due to theft or casualty, 

damage, impending sale, or other reason.  For any items of moveable equipment with an ac quisition 

cost greater than $5,000, the TC/Custodian should then notify the AA of the impending retirement.  
 

2. Preparation of ñAuthorization for Retirement of Equipmentò form 
 

The AA then completes the ñAuthorization for Retirement of Equipmentò form located on the PMG 
website:  

http://www.finance.upenn.edu/comptroller/forms/index.shtml#PropMan  

 
The following information is required:  

 
a. Asset Administrator Name ï name of the AA completing the form  

 

b. Intramural Address ï University address of the AA 
 

c. Mail Code ï Four-digit mail code of the AA 
 

d. E-mail Address ï e-mail address of the AA 
 

e. University Extension ï seven-digit telephone number of the AA  

 
f. Item# or Tag#  - The asset identification number assigned by BEN Assets or the University 

tag number affixed to the item (if the asset is taggable) and entered into BEN Assets.  
 

g. Description ï Description of the asset to be retired.  This may be the description in BEN 

Assets.   
 

h. Serial # - The serial number of the asset to be retired.  The AA should enter ñn/aò if the item 
does not have a serial number.  This information may be available in BEN Assets or on the 

asset itself. 

 
i. Account # Charged ï The seven-segment general ledger account to which the assetôs 

acquisition cost was charged.  This information is available in BEN Assets for any assets 
processed by Accounts Payable to a 187x object code. 

 
j.  Acquisition Date ï The date asset was acquired.  This information is available in BEN Assets. 

 

k. Date of Retirement ï The date on which the asset was physically disposed.  This date is used 
to calculate the gain or loss on retirement of the asset by BEN Assets.  For assets retired due 

to loss or theft, this is the actual date of the loss or theft.  If t he actual date of the loss or 
theft is unknown, then this should be the date the loss or theft was identified.   

 

This information should be provided by the TC/Custodian that performs the physical 
retirement of the asset. For retirements due to loss or the ft this date should be given to the 

AA when the retirement process is initiated, prior to approval of the form.  For retirements 
other than those due to loss or theft, this date is the date of the actual physical disposal of 

the asset, which occurs after t he form has been approved. 

http://www.finance.upenn.edu/comptroller/forms/index.shtml#PropMan
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l. Sales Price ï This is the sales price of the asset when sold, if applicable.  This should be 

completed by the TC/Custodian upon the sale of the asset, which occurs after the form has 

been approved. 
 

m. Sales Tax ï This is the sales tax collected by the Department upon the sale of the asset.  
Sales tax should be collected on all assets sold, unless the buyer is exempt from sales tax.  

Proof of tax-exempt status should be obtained and attached to the ñAuthorization for 

Retirement of Equipmentò form. This should be completed by the TC/Custodian upon the sale 
of the asset, which occurs after the form has been approved.  

 
n. Acquisition Cost ï The original cost of the asset when acquired.  This informatio n can be 

obtained by the AA from BEN Assets. 
 

o. Accumulated Depreciation ï This is the accumulated depreciation at the time of retirement.  
This information can be obtained by the AA from BEN Assets as of the date the form is 

completed.  Note that accumulated depreciation may change from the time the form is 

completed to the actual date of disposal. 
 

p. Book Value ï this is the difference between the Acquisition Cost and Accumulated 
Depreciation.  This amount is calculated and added by the AA. 

 

q. Method of Retirement ï This is the reason the asset is being retired.  The reason should be 

one of the reasons defined in BEN Assets, which include: 

 
 Casualty Loss ï Used when the loss is due to fire, collision or some other casualty loss.  

Risk Management should be notified of any casualty loss. 

 Extraordinary ï Oracle preset.  Not used. 

 Lost ï Used when an asset is lost and cannot be located. 

 Other ï Used for any retirement not covered above.  If this is used frequently, PMG 

should determine why and whether a new Retirement Type should be set up. 
 Return ï  This method should only be used by PMG and only when an asset has itôs 

acquisition cost adjusted to zero ($0.00) due to credit or other cost adjustment.  

 Sale ï Used for sales of assets. 

 Scrap ï Used when an asset is scrapped or trashed. 

 Theft ï Used for assets which are stolen.  Public Safety and Risk Management should be 

notified of any stolen assets. 

 Trade-in ï Used for any asset that at the end of its life is traded in for a new asset.  

 Transfer Out ï Used for any asset that is transferred out to another institution along with 

the grant funding that purchased the asset.  
 

After completion of these fields, the form should be signed by the Business Administrator, Chair or 
Director of the Department to which the asset belongs . 

 

3. Approval of Retirement 
 

Once the ñAuthorization for Retirement of Equipmentò form has been completed and signed by the 

Departmentôs Business Administrator, Chair or Director, as appropriate, the form must also be 
approved by the School/Center Senior Bus iness Administrator .   

 

If the acquisition cost of the asset exceeds $50,000, the form must also be approved by the 
Associate Treasurer .   

 
If the acquisition cost of the asset exceeds $250,000, the retirement must also be approved by the 

Vice -President of  Finance .   
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4. Additional Requirements for Assets Purchased with Grant Funds 

 

If the asset was acquired with grant funds, after the approvals have been received, the form should 
be forwarded to the ORS to review the gran t requirements regarding retirement of assets.  ORS 

should notate on the form any sponsor requirements or should notate ñn/aò if there are none.  ORS 
should then sign the form and return to the originating Department.  

 

5. Physical Disposal of Asset 
 

Once all approvals have been received and ORS has identified sponsor requirements, if applicable, 
the form is returned to the TC/Custodian who then physically disposes of the asset, except for assets 

retired due to theft or loss, which have already been physically disposed.  See also Financial Policy 
No. 1106.31 Plant Assets ï Disposal of Computing Equipment for steps to be completed prior to 

disposal of computing equipment. 

 
After the physical retirement of the asset, the AA must complete the Date of Reti rement, Sales Price 

and Sales Tax fields of the ñAuthorization for Retirement of Equipmentò form. 
 

6. Sale of Asset 

 
If the asset is to be sold, the Asset Administrator should query the asset in BEN Assets to determine 

the book value of the asset.  
 

If selling the equip ment - establish the fair market value:  
a. First, find current sale listings for the comparable equipment on an auction site, such as 

eBay.com, or by using other sources used for equipment valuation, such as Kelly Bluebook 

for vehicle values.  Refer to Financial Policy No. 1106.31 Plant Assets - Disposal of Computing 
Equipment, for more detailed information on sale of computers.  

b. Second, calculate the average cost based on the equipment in the last hours/stage of the 
auction to determine the sale price of the  equipment. Document this information.  

c. Third, the sale proceeds for any University of Pennsylvania property belong to the University.  

i. Checks should be payable to the ñTrustees of the University of Pennsylvaniaò.  
ii. State sales tax must be collected and remitted on all sales, except when the buyer is 

tax-exempt. Proof of tax-exempt status must be provided by the Buyer at the time of 
sale and maintained by the School/Center.  The tax may be included in the sales 

price. See the following example for calculation of tax amount:  

Sales price = $100.00.  
Tax Rate = 7% (PA=6% + Phila.=1%)  

Sales Revenue = $93.46 (100/1.07)  
Tax Amount = $6.54  

iii. Deposits for sales revenues should be recorded to object code 5602 Gain/Loss on 
Sale of Assets . 

iv. Deposits for sales tax should be recorded to object code 2111 A/P Sales Tax . The 

Sales & Use Tax worksheet should be completed and forwarded to Corporate Tax 
Office (see Sales & Use Tax Guidelines). 

 

7. Loss or Theft of Asset 

 
For any assets that have been stolen or suffered a casualty loss, the TC/Custodian must notify the 

Office of Risk Management of the loss.  Additionally, for any assets that have been stolen, the 

TC/Custodian must report the theft to the Office of Public Safety.  
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8. Recording Retirement in BEN Assets 

 
Once the asset has been physically disposed either by sale or other removal from the premises, the 

TC/Custodian should notify the AA of the disposal at which time the AA forwards the completed 

óAuthorization of Retirement of Equipmentô form to the SAA.  Once notified of the disposal, the SAA 
must then record the retirement within BEN Assets.   Go to the end of the narrative to see how 

to perform this activity  in BEN Assets . After the asset has been retired in the property system, 
BEN Assets will then at the end of the month, when monthly processing occurs create a journal that 

will post to BEN Financials to record the retirement in the General Ledger.   
 

The SAA must maintain the ñAuthorization for Retirement of Equipmentò forms on file on the 

premises or in archives in accordance with the Universityôs record retention policy for financial 
documents.  It is recommended that the SAA maintain the forms on the premises for six months after 

the end of the fiscal year to allow for a more timely  response to audit inquiries. 
 

Please n ote:  Assets cannot be retired in BEN Assets in the same month they are created 

in BEN Assets.  
 

9. Month-End and Year-End Considerations 
 

In order to ensure that retirements are recorded in the proper period, AAs, TCs an d Custodians 
should ensure that completed ñAuthorization for Retirement of Equipmentò forms are forwarded to 

the AA on a timely basis.  This is especially true at year end when delays in reporting current year 

retirements could result in the recording of r etirements crossing fiscal years.  For this reason all forms 
for retirements occurring in the current month should be forwarded to the AA at least three workdays 

prior to month -end.   
 

The AA is then responsible for ensuring that all retirements are entere d into BEN Assets on a timely 

basis and that retirements in the current month should be recorded in BEN Assets prior to the end of 
the day on the last work -day of the month.  

 
10. Reinstatement of Retired Asset 

 

In the event the retirement was incorrectly reco rded in BEN Assets (e.g. the wrong asset was retired 
in the system), the asset can be reinstated as an active asset by the AA or by PMG.  Once the asset 

has been reinstated, as part of the month -end processing, a journal is created by BEN Assets to 
reverse the retirement in the General Ledger and catch-up depreciation expense is recorded for the 

periods during which the asset was considered to have been retired, up to the assetôs becoming fully 
depreciated. 

 

Please note:  An asset cannot be reinstated if it  was retired in a prior fiscal year.   Contact 
the Property Management group if you discover an asset needs to be reinstated from a 

prior fiscal year.  
 

11. Cannibalization of Equipment for Parts 

 
In the event that an asset is no longer in service and its compon ent parts are removed and used to 

repair other equipment, once that asset can no longer be used for its original purpose, that asset is 
considered to be retired and must be scrapped following the procedures outlined here.  
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All other requirements of this procedure apply except that the manner of recording the retirement is 

electronic rather than manual.  A spreadsheet listing the information required for the ñAuthorization 

for Retirement of Equipmentò form may be attached to the form rather than submitting individual 
forms for each piece of equipment.  In this instance, summary acquisition cost, accumulated 

depreciation and book value should be reported on the face of the form.  Approvers should also initial 
and date the spreadsheet. 

 

12. Retirement of Land and Buildings 
 

Facilities and Real Estate Services (FRES) is required to notify PMG of any retirement of land and/or 
buildings due to loss, sale, transfer or any other reason.  Upon notification of the retirement, PMG wil l 

then record the retirement within BEN Assets.  Any proceeds from the sale of land or buildings should 
be deposited into object code 5602 Gain/Loss on Sale of Assets .  Advance notice of any 

impending sales or retirements is recommended so that the accounting, especially related to any 

complex real estate transactions, can be reviewed and, if necessary, discussed with and approved by 
the Universityôs external auditors. 
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In order to perform the óretirementô or óreinstatementô functions in BEN Assets, navigate to the Asset 

Workbench menu option.   

 

 From the Senior Asset 

Administrator  responsibility, click on 

Assets>Asset Workbench from 

either the BEN Financials Homepage or 

the Navigator 

F The ability to óRetireô and 

óReinstateô an asset can only be 

performed from the Senior Asset 

Administrator responsibility.   

o Enter any of the same search criteria 

described in the Inquiry section  

o Click on [Find]   

 

F Reminder:  Assets cannot be retired in BEN Assets in the same month they ar e 
created in BEN Assets.  
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o Click on [Retirements]  

 
o Type 

óUNIVERSITY 

BOOKô  

o In the óUnits 

Retiredô field, 

enter ó1ô 

o In the Retirement 

Method field, click 

on the LOV  

o Select the 

reason for 

Retirement 

o Click [OK]  

o Click [Done]  
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o To view the results of the retirement, navigate to the Inquiry>Financial Transactions  menu path 

o Click on [Books]  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

o Click on [Transactions]  

 

 
 

 

 

After journals 
created  

Before 

journals 
created  
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o Note the óFull Retirementô line below 

 

Click on [Details]  
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If an asset is retired in error, e.g. asset previously thought lost was found follow the same navigational 

path as óRetirementô.   

F Please note:  Can only do after óGains and Lossesô is run by Property Management Group.  This is 
run on a nightly basis.  
 

o Important!   Press [Ctrl] F11  to arrive at the form  

o Click on [Reinstate] ; click [OK]  

F Itôs not necessary to click on [Done]  

o The asset has now be re-instated from óRetirementô 

 

o Below is the óTransaction Historyô after the óReinstateô has been processed 

 

Please note:  An asset cannot 
be reinstated if it was retired 

in a prior f iscal year .   

Contact the Property 
Management G roup if 

you discover an asset needs 
to be reinstated from a prior 

fiscal year. 



 

é.              Financial Training Department 84  

BEN Assets ï Undo Retirement  
 
On occasion there may be times when a Senior Asset Administrator or an Asset Administrator discovers 

on the same day  an asset is retired a mistake has been made and there is a need to un-retire an asset.   

F Use óReinstateô in cases where the asset has been retired more than one day but not more than 
one fiscal year.   

 

 From the Senior Asset Administrator  

responsibility, click on Assets>Asset 

Workbench from either the BEN 

Financials Homepage or the Navigator 

o Enter any of the same search criteria 

described in the óInquiryô section in this 

case the Asset Number to be óUn-retiredô 

o Click on [Find]  
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o Click on [Retirements]  

 

o Important!  When you arrive at this form, press [Ctrl] F11  immediately. 
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o The following four pop -up boxes will appear  

Click [OK]  for each one 
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o Finally you arrive at this screen 

 

o Click on [Undo Retirement]  

o This pop-up box will appear.  Click [OK] . 

 

   

 

 

 

 

 

 

Please note:   If you  tried to 

enter óUniversity Bookô or any 
other field before pressing Ctrl 

F11, this is what would appear.  
Itôs best to then press [Cancel] 

and begin again. 
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o Navigate to óTransaction Historyô to view the form óBeforeô the óUn-Retireô  and after the óUn-

Retire is completed ï not this is not the same asset as the previous page 

   

 

After  Un-
Retire  

Before Un-
Retire  
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Other>Requests  

 
There are a few reports available from the BEN Assets application however the majority of reports are 

housed in BEN Reports.  Ad hoc reporting for BEN Assets is also available in the Data Warehouse.  This 

section covers how to retrieve a report from the BEN Assets application only. 

 

 From the Senior Asset 

Administrator  or the Asset  

Administrator  responsibility, click 

on Othe r>Requests>Run from 

either the BEN Financials Homepage 

or the Navigator 

o On the Single Request default, click 

[OK]  
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Other>Requests  (continued)  
 
o The three reports available to the user from BEN Assets are as follows: 

 Asset Register Report 

 Asset Category Listing 

 Purchase Order Summary Report 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
o Parameters 

 In the Book field, type UNIVERSITY BOOK (only option here) 

 In the From Asset Number field, type the asset number desired  

 In the To Asset Number field, type the asset number desired 

F Caution!  It is recommended that you enter the same asset number in the From and To 
field.  BEN Assets is an unsecured responsibility which allows for access to all of the 
University assets, many which may not be your School/Center assets.  Use these parameter 
fields carefully.  



 

é.              Financial Training Department 91  

BEN Assets ï Reporting  (continued)  
 

Other>Requests  (continued)  
 

o Click on [Submit]  

 

o You will be taken to the óRequestsô window 

 

Click here when the phase is 
óPendingô or óRunningô to refresh 

window until phase is 
óCompletedô 

F When óPendingô or óRunningô, 
click on Tools>Manager to see 
Concurrent Manager Queue  
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Other>Requests  (con tinued)  
 

o  When report óCompletedô, click on [View Output]  

 

o Use the buttons at the bottom and the scroll bars on the bottom and right to view your report  

F It is recommended that you view the report on -line first, prior to printing, to ensure this is the 
report you wish to, in fact, print.  
 

 When finished viewing, close the window to return to óRequestsô 

Printing Requests  

 

 Highlight the report you would like to print by placing your cursor on the line  

 From the menu, click on Tools>Reprint  

F The óReprintô option is not available when not in the óRequestsô window   

 Click on [Refresh Data]  to see the reprint request  

 

Click here when the phase is 

óPendingô or óRunningô to refresh 
window until phase is óCompletedô 

 

F When óPendingô or óRunningô, 
click on Tools>Manager to see 

Concurrent Manager Queue  
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Other>Requests  (continued)  

 

Buttons on the óSubmit Requestsô window 
 

Use the Copy button to take advantage of p reviously entered request submissions.  
You can change fields, such as Period, for reports you submit frequently with the   

                                 same parameters. 

F You canôt get rid of óNotificationsô if the previously entered request had them, they will be copied.  
You can change them but you canôt delete them. 

 

The scheduling window provides you with several scheduling options. You can 

choose to re-use a schedule you previously defined and saved, or define a new 

schedule. You can define your schedule to run a request as soon as possible, at a 
specific time, or repeatedly at specific intervals, on specific days of the week or month.  

 

 When you click on [Schedule]  the Schedule window opens.  Select from the following:  

 Apply a Saved Schedule  

 Allows you to re-use a previously defined and saved schedule. You may modify the saved 

schedule for this one submission or save the modified schedule with a new name for future use.  

F If you intend to use the saved 
schedule as defined, click [OK] 
 

 As Soon as Pos sible  

 Submits your request as soon as 

possible. If you select this 

schedule type, click [OK].  

 

 Once  

 Submits your request once at the 

time and date you specify  

 

 Periodically  

 Submits your request repeatedly at the interval you specify  

 On Specific Days  

 Submits your request repeatedly on specific days of the week or month  

 To save your schedule, check the Save this schedule  check box 

 You must also provide a unique name for each schedule you save 

 Optionally, enter a description of your schedule 

Viewing Requests  

If you ever need to view your request(s),  whether completed or in progress, you can 

simply click on View>Requests from the menu, in any responsibility, including PO. 

Manager.  
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Other>Requests  (continued)  
 
Buttons on the óSubmit Requestsô window (continued) 
 

 

Upon completion, all output 

files are saved.  You can also notify others, with BEN 

Financials access, about the report.  It will appear in 

their óNotificationsô on the Navigator. 

 

When all information is 

completed, click here.  

 

Use this button to cancel the 

request. 

 

Buttons on the óRequestsô window 
 

 

Click inter-
mittently to 
see Phase 
field change 
from 
óPendingô to 
óRunningô to  
óCompletedô  

Brings up the Find Requests 
window where you can request óallô 
or those óin progressô.  Cannot 

submit new requests from here.  

Begin new 
request here 

Shows input 
information 
about  a 
request 

Use Cancel Request to 
terminate requests in 
óRunningô or óPendingô 
phase  
 

Click here to see, if report 
completed successfully, 
the date and time it 

began and ended 

Click here to see if 
there is any problem 
ïsolving information 
regarding your 
request 

Use Hold 
Request if 
the request 
is Pending 

Click here to 
view your 
completed 
report prior to 
printing 

Person notified 

can only see 
request one time  
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 Invoice Inquiry  

 
In order to view the actual ósourceô information for an asset, an óInvoice Inquiryô can be performed.  

 

 From the Senior Asset Administrator  or 

the Asset  Administrator  responsibility, 

click on Invoice Inquiry> Invoices from 

either the BEN Financials Homepage or the 

Navigator 

 

 
 
 
 
 

 

 

 
o Recall from the Inquiry section, tha t the source information, i.e. Invoice Number or PO Number is 

available from the Financial Information >  [Source Lines]  
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Invoice Inquiry (continued)  
 
o Enter search criteria using one field or a combination of fields.  For example you may use:  

 

1) PO # or  
2) Supplier and Invoice # or  

3) Supplier and amount range 

 

o The Invoices form opens  

F Note the paperclip with th e piece of paper on the toolbar  

To review an image of the invoice, click on the Attachments   icon  on the Toolbar to invoke 
MarkView 

software. 
Accounts Payable 

creates an 

electronic image 
of supplier 

invoices and C-
368 forms and 

the attached 

invoice. Items not 
imaged include: 

C-1, C-1A, and C-
368 forms (when 

used for travel 
purposes), petty 

cash 

reimbursement 
requests and 

supporting 
document 

(contracts, 

competitive bids) 
for Purchase 

Orders. 
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Invoice  Inquiry (continued)  
 
o Enter your BEN Financials User name and Password to 

retrieve the invoice 

o View the invoice below  

  

  

  

  

 

F For more information regarding óInvoice Imagesô see the óAccounts Payable Invoice Imaging User 
Guideô http://www.finance.upenn.edu/ftd/documentation/benpays.pdf   

 

 

 

 

http://www.finance.upenn.edu/ftd/documentation/benpays.pdf
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Invoice Inquiry (continued)  
 

o In order to view the PO from the Invoice Inquiry menu  path, click on [Overview]  

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

o Click on [View PO]  
 

 

[Invoices]  takes 

you back to the form 
above 
 

Click [Distribu tions]  

to go to account 
information for this PO 
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Invoice Inquiry (continued)  
 
o Scroll to the right to see more information regarding the Purchase Order  

 

o Click on [Distributions] to see the original account number charged on the  Purchase Order 

o Scroll to the right to see the óCharge Accountô for this Purchase Order 
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Invoice Inquiry (continued)  
 
Viewing Quantity Detail  
 

 

 

 

 

 

1.  Quantity  - is the number of item(s) or amount of the Purchase Order  

2.  Quantity Billed  - is the number of item(s) or amount of the invoice sent to Accounts Payable 

by the supplier 

3.  Quantity Received - is the number of item(s) or amount that has been receipted by Penn  

F If the Quantity and/or the Quantity Received does not ómatchô the Quantity Billed according 

to the established criteria, the invoice will go on Hold .   

F See the BEN Buys Accounts Payable Invoice  Imaging User Guide  regarding 

managing invoices placed on óHoldô 

 In this example the quantity ordered is greater than the quantity billed.    However, since the 

quantity received equals the quantity billed Accounts Payable will automatically pay this invoice 

for the amount billed/received.  

 Additional payments can be made from this PO if the PO is not ófinally closedô by Accounts 

Payable. 

F See the PO Manager User Guide  for information on how to request a óFinal Closeô on a 

Purchase Order.  

 Click [Distributions]  to go to account information for this PO  

2 

3 

1 

2 

2 
1 
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Invoice Inquiry (continued)    
 
The Invoices form will list all invoices charged against the specified purchase order.  Your first indication 
as to whether or not a payment was processed is the Amount Paid field.  If no payment is reflected in 

this field the invoice may have been placed on óHoldô.   

Holds  

 

The Holds  field will indicate the number  of holds against a particular invoice.  Click on the Holds  tab to 

ascertain the type(s) of hold against the invoice.  

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

F For more information regarding óHoldsô see the óAccounts Payable Invoice Imaging User Guideô 
http://www.finance.upenn.edu/ftd/documentation/benpays.pdf   

Hold s 
Tab  

http://www.finance.upenn.edu/ftd/documentation/benpays.pdf
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Invoice Inquiry (continued)    

 
The Invoices form will list all invoices charged against the specified purchase order.  Your first indicat ion 
as to whether or not a payment was processed is the Amount Paid field.  If no payment is reflected in 

this field the invoice may have been placed on óHoldô.   

Holds  

 

The Holds  field will indicate the number of holds against a particular invoice.  Cli ck on the Holds  tab to 

ascertain the type(s) of hold against the invoice.  

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

F For more information regarding óHoldsô see the óAccounts Payable Invoice Imaging User Guideô 
http://www.finance.upenn.edu/ftd/documentation/benpays.pdf   

 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

Hold s 
Tab  

http://www.finance.upenn.edu/ftd/documentation/benpays.pdf
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Invoice Inquiry (continued)  

Payments  
 

If a payment has been processed click on the Payment  Tab to access detailed payment information, 
such as the payment method, check/document number and payment date, etc.  

 
F Note:

 Payme
nt Terms -  Checks are produced based upon the payment terms that are assigned to the 
supplier.  
 

a. Employees  are created with terms of òNet 2" which means that a check will be 

generated two days after t he invoice date  that is 
entered in the Accounts Payable system when the 

particular form is processed.  

b. Most suppliers  are created with payment terms of 
ñNet 30" which means the payment will be made 30 

days AFTER the invoice date .  However, some 
suppliers have a payment term of immediate due to a prompt pay discount offer with 

the supplier. 

 
 

 
 Click on [Payment Overview]   

View 
Payments  
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Invoice Inquiry (continued)  
 

Payments (continued)  
 

 The Payment Overview form has more information about the check, Supplier address and Bank 

 

 

 Click on [Payments]  for more information regarding the payment  

Date check 
cashed appears 

here when 
Supplier cashes 
check  

List  of all 

invoices paid on 

check  
 

Supplier ad dress 
where check is 

mailed  

 

Universityôs 

bank 
information  
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Appendix A 

Viewing and Creating Folders  

 

A folder block is a special block whose field and record layout you can customize. The following helps you 
distinguish a folder block fr om a regular block:  

 
           

 An enabled Folder 

menu  appears in the 
main menu bar when 

your cursor is in a folder 

block. 
 

 An Open Folder icon  

appears in the upper left 
hand corner of the form.  

 

 An enabled Folders 

Tool  icon  appears on 
the toolbar when your 

cursor is in a folder 
block. 

 
 

 

Clicking on the Folders Tool   icon  will open the Folders Tools box. 
 

Your Folders Tool options are as follows: 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 

(From left to 
Right)  
Open  
Save  

New  
Delete  

 

(From left to right)  
Widen Field  

Shrink Field  
Show Field  

Hide Field  

 

Arrows allow you 
to move a 

selected column  
 




























